Copyright
© Copyright 2015, Welch Allyn. All rights are reserved. To support the intended use of the product described in this publication, the purchaser of the product is permitted to copy this publication, for internal distribution only, from the media provided by Welch Allyn. No other use, reproduction, or distribution of this publication, or any part of it, is permitted without written permission from Welch Allyn. Welch Allyn assumes no responsibility for any injury to anyone, or for any illegal or improper use of the product, that may result from failure to use this product in accordance with the instructions, cautions, warnings, or statement of intended use published in this manual. Unauthorized copying of this publication may not only infringe copyright but also reduce the ability of Welch Allyn to provide accurate and up-to-date information to users and operators alike.

Welch Allyn®, CardioPerfect® Workstation and SpiroPerfect® are registered trademarks of Welch Allyn.

Software in this product is Copyright 2015, Welch Allyn. All rights are reserved. The software is protected by United States of America copyright laws and international treaty provisions applicable worldwide. Under such laws, the licensee is entitled to use the copy of the software provided on the original distribution medium. The software may not be copied, decompiled, reverse-engineered, disassembled or otherwise reduced to human-perceivable form. This is not a sale of the software or any copy of the software; all right, title and ownership of the software remains with Welch Allyn.

The information contained in this manual is subject to change without notice. All changes will be in compliance with regulations governing manufacture of medical equipment.

User responsibility
This product is designed to perform in conformity with the description thereof contained in this manual and accompanying labels and inserts, when assembled, operated, maintained and repaired in accordance with the instructions provided. A defective product should not be used. Parts that are broken, plainly worn, missing or incomplete, distorted or contaminated should be replaced immediately. Should any repair or replacement become necessary, we recommend that service be performed at the nearest approved service center. The user of the product shall have the sole responsibility for any malfunction, which results from improper use, faulty maintenance, improper repair, damage or alteration by anyone other than Welch Allyn or their authorized service personnel.

Accessories
The Welch Allyn warranty can only be honored if you use Welch Allyn approved accessories and replacement parts.

Caution
Use of accessories other than those recommended by Welch Allyn may compromise product performance.
Warranty, Service, and Spare Parts

Warranty
All repairs on products under warranty must be performed or approved by Welch Allyn. Unauthorized repairs will void the warranty. In addition, whether or not covered under warranty, any product repair shall exclusively be performed by Welch Allyn certified service personnel.

Assistance and Parts
If the product fails to function properly or if assistance, service, or spare parts are required, contact the nearest Welch Allyn Technical Support Center.

USA 1-800-535-6663  Canada 1-800-561-8797
Latin America (+1) 305-669-9003  South Africa (+27) 11-777-7555
European Call Center (+353) 46-90-67790  Australia (+61) 2-9638-3000
United Kingdom (+44) 207-365-6780  Singapore (+65) 6419-8100
France (+33) 1-55-69-58-49  Japan (+81) 42-703-6084
Germany (+49) 695-098-5132  China (+86) 21-6327-9631
Netherlands (+31) 202-061-360  Sweden (+46) 85-853-65-51

Before contacting Welch Allyn it is helpful to attempt to duplicate the problem and to check all accessories to ensure that they are not the cause of the problem.

When calling, please be prepared to provide:
- Product name and model number and complete description of the problem
- The serial number of your product (if applicable)
- The complete name, address and phone number of your facility
- For out-of-warranty repairs or spare parts orders, a purchase order (or credit card) number
- For parts order, the required spare or replacement part number(s)

Repairs
If your product requires warranty, extended warranty, or non-warranty repair service, please call first the nearest Welch Allyn Technical Support Center. A representative will assist you troubleshooting the problem and will make every effort to solve it over the phone, avoiding potential unnecessary return.

In case the return cannot be avoided, the representative will record all necessary information and will provide a Return Material Authorization (RMA) number, as well as the appropriate return address. A Return Material Authorization (RMA) number must be obtained prior to any return.

Note Welch Allyn does not accept returned products without an RMA.

Packing Instructions
If you have to return goods for service, follow these recommended packing instructions:
- Remove all hoses, cables, sensors, power cords, and ancillary products (as appropriate) before packing, unless you suspect they are associated with the problem.
- Wherever possible use the original shipping carton and packing materials.
- Include a packing list and the Welch Allyn Return Material Authorization (RMA) number.

It is recommended that all returned goods be insured. Claims for loss or damage to the product must be initiated by the sender.
CardioPerfect Workstation
SpiroPerfect Module – User Manual

Limited Warranty Statement
Welch Allyn, Inc. warrants that the SpiroPerfect computer based Spirometer you have purchased (the Product) meets the labeled specifications of the Product and will be free from defects in materials and workmanship that occur within 1 year after the date of purchase. Accessories used with the Product are warranted for 90 days after the date of purchase. Such accessories include: disposable flow transducers, pressure tubing, and nose clip.

The date of purchase is: 1) the date specified in our records, if you purchased the Product directly from us, 2) the date specified in the warranty registration card that we ask you to send to us, or 3) if you don’t return the warranty registration card, 120 days after the date on which the Product was sold to the dealer from whom you bought the Product, as documented in our records.

This warranty does not cover damage caused by: 1) handling during shipping, 2) use or maintenance contrary to labeled instructions, 3) alteration or repair by anyone not authorized by Welch Allyn, and 4) accidents.

You assume all responsibility for use of the Product with any hardware or software that does not meet the system requirements described in the Product documentation.

If a Product or accessory covered by this warranty is determined to be defective because of defective materials, components, or workmanship, and the warranty claim is made within the warranty period described above, Welch Allyn will, at its discretion, repair or replace the defective Product or accessory free of charge.

You must obtain a return authorization from Welch Allyn to return your Product before you send it to Welch Allyn’s designated service center for repair.

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. WELCH ALYN’S OBLIGATION UNDER THIS WARRANTY IS LIMITED TO REPAIR OR REPLACEMENT OF PRODUCTS CONTAINING A DEFECT. WELCH ALYN IS NOT RESPONSIBLE FOR ANY INDIRECT OR CONSEQUENTIAL DAMAGES RESULTING FROM A PRODUCT DEFECT COVERED BY THE WARRANTY.
# Table of Contents

1 Introduction .................................................................................................................. 8  
   1.1 About This Manual ................................................................................................. 8  
   1.2 Symbols .................................................................................................................. 9  
   1.3 Using the Spirometer Safely .................................................................................. 11  
   1.4 Product Overview ................................................................................................. 13  
   1.5 Features ................................................................................................................ 13  

2 General information ........................................................................................................ 15  
   2.1 Welcome ............................................................................................................... 15  
   2.2 Intended Use / Indications for Use ......................................................................... 15  
   2.3 Contraindications ................................................................................................. 15  
   2.4 Important Considerations ...................................................................................... 16  

3 Installing the SpiroPerfect Spirometer ......................................................................... 17  
   3.1 Configuring the Welch Allyn CardioPerfect Workstation .................................... 18  

4 The Spirometer Window .................................................................................................. 19  

5 Customizing the Spirometry Module .............................................................................. 21  
   5.1 General Tab .......................................................................................................... 21  
   5.2 Viewing Tab ......................................................................................................... 23  
   5.3 Parameters Tab ...................................................................................................... 25  
   5.4 Printing Tab ......................................................................................................... 27  
   5.5 Recording Tab ...................................................................................................... 29  
   5.6 Customize the spiro.txt file .................................................................................. 30  

6 Ambient Settings /Temperature, Humidity and Pressure ............................................. 31  
   6.1 Why the Workstation needs Ambient Setting Information ................................... 31  
   6.2 When to Adjust the Ambient Settings .................................................................. 31  
   6.3 Adjusting the Ambient Settings .......................................................................... 31  

7 Calibration of Flow Sensor ............................................................................................. 33  
   7.1 Preparing calibration ......................................................................................... 33  
   7.2 The Calibration Process ..................................................................................... 33  
   7.3 View Calibration Results .................................................................................... 38  
   7.4 Error Messages Associated with Failed Calibration ......................................... 39  
   7.5 Calibration log .................................................................................................... 40  

8 Recording Spirometry Tests ........................................................................................... 41
1 Introduction

1.1 About This Manual

This manual is written for clinical professionals performing pulmonary function testing. Users must be familiar with measurements and the clinical significance of basic spirometry products.

Caregivers need to know how to properly coach patients, recognize acceptable waveforms and know whether results are reproducible or not and whether they meet ATS criteria or not.

The hospital’s Biomedical/IT support staff shall require primary skills including disciplines related to maintenance and servicing computer controls/platforms. It is recommended that users attend a certified spirometry training course. The instructions given here are only a guide and should not be used to train a technician.

For definitions of specialized terms and abbreviations related to spirometry, see the Glossary.

Before using the spirometer, all users and technicians must read and understand this manual and all other information accompanying the SpiroPerfect spirometry option and the CardioPerfect workstation.

Note

This manual supplements the CardioPerfect workstation manual, entitled CardioPerfect Workstation User Manual. For information that the workstation and spirometry functions share — for example, instructions for moving through the menus, searching for patient data — see the CardioPerfect workstation manual.

Please take note of all safety precautions and warnings provided with this device before using this device and the accompanying software.

We at Welch Allyn are dedicated to provide safe products to our customers. It is the user’s responsibility to follow the rules of safety as established for their protection and for the protection of their patients as described in this manual. Please take special note of the safety and precautions as described in Using the Spirometer Safely on page 11.
1.2 Symbols

The symbols shown below may appear on the spirometer components, on the packaging, on the shipping container, or in this manual.

<table>
<thead>
<tr>
<th>Safety Symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td>WARNING</td>
</tr>
<tr>
<td>CAUTION</td>
</tr>
<tr>
<td>![Exclamation mark]</td>
</tr>
<tr>
<td>![Triangle]</td>
</tr>
<tr>
<td>Single Use - Do Not Reuse</td>
</tr>
<tr>
<td>IP20</td>
</tr>
<tr>
<td>Protected against the ingress of solid foreign objects ≥ 12.5 mm diameter, not protected against the ingress of water.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Shipping, Storing, and Environment Symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Exclamation mark] YYYY-MM</td>
</tr>
<tr>
<td>Expiration Date</td>
</tr>
<tr>
<td>![Exclamation mark] Keep away from sunlight</td>
</tr>
<tr>
<td>![Exclamation mark] Stacking limits</td>
</tr>
<tr>
<td>![Exclamation mark] Fragile</td>
</tr>
<tr>
<td>![Exclamation mark] Keep away from rain</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Certification Symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Exclamation mark] 0297</td>
</tr>
<tr>
<td>CE Mark for Class Is, Im, Ila, IIb &amp; III</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Authorized Representative in the European Community</th>
</tr>
</thead>
</table>
# Conventions

<table>
<thead>
<tr>
<th><strong>SN</strong></th>
<th>Serial Number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>REF</strong></td>
<td>Product Identifier</td>
</tr>
<tr>
<td><img src="image" alt="Temperature Range" /></td>
<td>Manufacture Date: YYYY-MM-DD</td>
</tr>
<tr>
<td><img src="image" alt="Reorder Number" /></td>
<td>Reorder Number</td>
</tr>
<tr>
<td><img src="image" alt="Do not dispose of in trash, for devices" /></td>
<td>Do not dispose of in trash, for devices</td>
</tr>
<tr>
<td><img src="image" alt="Consult operating instructions/directions for use (DFU). A copy of the DFU is available on this website. A printed copy of the DFU can be ordered from Welch Allyn for delivery within 7 calendar days." /></td>
<td>Consult operating instructions/directions for use (DFU). A copy of the DFU is available on this website. A printed copy of the DFU can be ordered from Welch Allyn for delivery within 7 calendar days.</td>
</tr>
<tr>
<td><img src="image" alt="Global Trade Item Number" /></td>
<td>Global Trade Item Number</td>
</tr>
<tr>
<td><img src="image" alt="Rx ONLY" /></td>
<td>By prescription or order of physician or dentist</td>
</tr>
<tr>
<td><img src="image" alt="Atmospheric pressure limitation" /></td>
<td>Atmospheric pressure limitation</td>
</tr>
<tr>
<td><img src="image" alt="Humidity limitation" /></td>
<td>Humidity limitation</td>
</tr>
</tbody>
</table>
1.3 Using the Spirometer Safely

Before using or servicing the spirometer, you must read and understand the following safety-related information.

**WARNING:**

Do not perform spirometry test if any of the following conditions apply to the patient:

- hemoptysis of unknown origin (forced expiratory maneuver may aggravate the underlying condition);
- pneumothorax;
- unstable cardiovascular status (forced expiratory maneuver may worsen angina or cause changes in blood pressure) or recent myocardial infarction or pulmonary embolus;
- thoracic, abdominal, or cerebral aneurysms (danger of rupture due to increased thoracic pressure);
- recent eye surgery (e.g., cataract);
- presence of an acute disease process that might interfere with test performance (e.g., nausea, vomiting);
- recent surgery of thorax or abdomen.

**WARNING** The spirometer captures and presents data reflecting a patient’s physiological condition. When reviewed by a trained physician or clinician, this data can be useful in determining a diagnosis. However, the data should not be used as a sole means for determining a patient’s diagnosis.

**WARNING** To minimize chances of a misdiagnosis, it is the physician’s responsibility to assure that spirometry tests are properly administered, evaluated, and interpreted.

**WARNING** People may become light-headed, dizzy, or even faint during a spirometry effort. Watch patients closely. If they choose to stand during testing, keep a chair immediately behind them. If there is any reason for concern, stop the test and take appropriate action.

**WARNING** To prevent cross-contamination, do not try to clean the flow transducers and nose clips. Discard these items after a single patient use.

**WARNING** The American Thoracic Society (ATS) recommends using gloves when replacing disposable flow transducers, and washing hands after touching them.

**WARNING** No modification of this equipment is allowed.

**WARNING** Fire and explosion hazard. Do not operate the spirometer in the presence of a flammable anesthetic mixture with air, oxygen, or nitrous oxide; in oxygen-enriched environments; or in any other potentially explosive environment.
**WARNING:**

The CardioPerfect family of devices is an integral part of a personal computer based diagnostic system. The user shall adhere to warnings in order to ensure safe and reliable performance of the system.

The personal computer (non-medical electrical equipment) shall be situated outside the patient environment (reference IEC 60601-1).

The personal computer used should adhere to the appropriate safety standard for non-medical electrical equipment (IEC 60950, or its national variants), and use of an isolation transformer is recommended.

The personal computer used should adhere to the appropriate electromagnetic compatibility (EMC) standard for non-medical electrical equipment (CISPR 22/24 - FCC Part 15 - CE, or related national variants).

If it is required for the personal computer to be situated within the patient environment, it is the responsibility of the user to ensure that the system provides a level of safety in compliance with IEC 60601-1.

**WARNING** A color printer and a color printout are recommended for printing Spirometry reports. Printing these reports with a monochrome printer or in black and white can lead to confusion as it is not easy to identify which curve is a Pre and which is a Post effort.

---

**CAUTION** Do not clean the pressure tubing or sensor. Trapped moisture could affect their accuracy. Replace the pressure tubing when it becomes dirty. Replace the sensor when it becomes faulty.

**CAUTION** You cannot clean the spirometer or any of its components.

**CAUTION** If you choose to clean the calibrations syringe, clean the outer surface of the syringe with only the following solutions or wipes:

- Solution of dish soap and water, ½ tsp per cup of water
- Solution of bleach and water, 1 part bleach (6% sodium hypochlorite) with 9 parts water
- Isopropyl Alcohol and water, 70% by volume
- PDI Sani-Cloth Plus wipes (14.85% Isopropanol)
- Cavi-Wipes (17.2% Isopropanol)

**CAUTION** Use only parts and accessories supplied with the device and available through Welch Allyn. The use of accessories other than those specified may result in degraded performance of the device.

**CAUTION** When you put the spirometer away, store its pressure tubing in a basket or drawer or other place that prevents compression or kinking.

**CAUTION** Avoid installing the spirometer in direct sunlight or in a location where it may be affected by significant changes in humidity, ventilation, or airborne particles containing dust, salt or sulfur.

**CAUTION** Keep the spirometer away from splashing fluids.
1.4 Product Overview

SpiroPerfect performs FVC, SVC and MVV testing, including pre-post testing. It instantly displays flow-volume curves and depicts inspiratory and expiratory measurements.

For details, see the following sections:
- Features (page 13)
- Ordering Information for Replacement Parts (page 76)
- Specifications (page 80)

Figure 1.1 Components of the SpiroPerfect Spirometer

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disposable Flow Transducer</td>
<td>For single patient use only to minimize the risk of cross contamination.</td>
</tr>
<tr>
<td>Pressure Tubing</td>
<td>Connects the flow transducers to the Spirometer sensor.</td>
</tr>
<tr>
<td>USB Sensor</td>
<td>Connects to the USB port of your PC. Converts pressure to airflow.</td>
</tr>
<tr>
<td>Assembled SpiroPerfect Spirometer</td>
<td>Consists of: Disposable Flow transducer, Pressure tubing, and USB Sensor.</td>
</tr>
<tr>
<td>Nose Clip</td>
<td>Highly recommended during testing to avoid air leaks. Unless a medical condition makes it uncomfortable or unpractical to use it, in which case, the clinician should record that the nose clip was not used.</td>
</tr>
<tr>
<td>3 liter Calibration syringe</td>
<td>For daily use, to calibrate the Welch Allyn SpiroPerfect spirometer for accuracy.</td>
</tr>
</tbody>
</table>

1.5 Features

- Automatic interpretation and comparison to best pre-bronchodilator.
- Real-time flow/volume and volume/time graphs.
- Incentive graphic for pediatric patient coaching.
- Multiple predicted norms.
Customizable report formats.
Validated to meet the American Thoracic Society spirometry accuracy standards for both ambient and BTPS humidified air.
Instant quality and variability check for proper test performance.
Single-stroke and multiple-stroke calibration protocols.
Reduced risk of cross contamination with Welch Allyn single-use, disposable flow transducers.
Meets all industry standards, including ATS, NIOSH, OSHA and Social Security.
Trending of several different tests from the same patient.
2 General information

2.1 Welcome

Welcome to the SpiroPerfect module of the Welch Allyn CardioPerfect Workstation. With this module, you can record, view and interpret spirometric tests. You can also use it to print spirometry tests in various formats.

The SpiroPerfect module exceeds the recommendations for spirometry of the American Thoracic Society (ATS).

This manual contains specific information about the SpiroPerfect module of the Welch Allyn CardioPerfect Workstation. For all general information about the workstation software, please refer to the Workstation manual, which describes:

- Creating and editing Patient cards
- General information about printing

For further information on installation and configuration please refer to the Workstation Installation manual.

2.2 Intended Use / Indications for Use

Using the optional spirometry module and associated accessories to acquire, view, store, and print measures and waveforms of pulmonary function. The spirometer should only be used with patients able to understand the instructions for performing the test.

Indications for spirometry include, but are not limited to, the following:

- Shortness of breath
- Chronic cough
- Occupational exposure to dust and chemicals
- Assist in the diagnosis of Bronchitis
- Assist in the diagnosis of Asthma
- Wheezing
- Assist in the monitoring of bronchodilators

2.3 Contraindications

Relative contraindications to performing spirometry are [AARC Clinical Practice Guideline Spirometry, 1996 Update]:

- hemoptysis of unknown origin (forced expiratory maneuver may aggravate the underlying condition);
- pneumothorax;
- unstable cardiovascular status (forced expiratory maneuver may worsen angina or cause changes in blood pressure) or recent myocardial infarction or pulmonary embolus;
- thoracic, abdominal, or cerebral aneurysms (danger of rupture due to increased thoracic pressure);
- recent eye surgery (e.g., cataract);
- presence of an acute disease process that might interfere with test performance (e.g., nausea, vomiting);
- recent surgery of thorax or abdomen.
2.4 Important Considerations

The Spirometer should not be used if any of the following conditions exist or are thought to exist:

- The spirometer is not regularly calibrated.
- The maintenance instructions listed in section 13 are not satisfactorily completed.
- Any part of the equipment or system is known, or suspected, to be defective.
3 Installing the SpiroPerfect Spirometer

The SpiroPerfect Spirometer consists of two elements: the spirometry sensor, and the software that runs on the computer to which the sensor is connected. Before you can start recording spirometry tests, you need to:

- Connect the sensor to the computer.

  **CAUTION** Always use the USB extension cable. The USB extension cable prevents damage to the spirometer.

- Configure the software.

**Warm up the Spirometer**

After connecting the device it is recommended to let the Spirometer warm up.

1. Connect the Spirometer to the computer.
2. Open the Spiro module.
   The sensor starts to warm up as soon as the SpiroPerfect module is opened.
3. Wait for at least 5 minutes before starting a new test.

**Flow sensor with USB connection:**

**SpiroPerfect from Welch Allyn**

OEM SpiroPerfect manufactured by Medikro Oy, Finland for Welch Allyn Inc, USA.

For information on connecting the Flow sensor with USB connection see section 3 Installing the SpiroPerfect Spirometer.
Flow sensor with serial connection:

SpiroPerfect from Welch Allyn

OEM SpiroPerfect manufactured by Medikro Oy, Finland for Welch Allyn Inc, USA.

The Flow sensor with serial connection is ready for use after plugging it into the computer. No further driver needs to be installed.

3.1 Configuring the Welch Allyn CardioPerfect Workstation

After connecting the spirometry sensor, you need to configure Welch Allyn CardioPerfect Workstation.

To configure Welch Allyn CardioPerfect Workstation for use with the sensor:

2. In the File menu, click Settings and click Spirometry.
3. Click the Recording tab.
4. Select Welch Allyn SpiroPerfect.
5. Click OK to save the settings.
4 The Spirometer Window

This section guides you through the various parts of SpiroPerfect. The structure of the workspace is similar to the other Welch Allyn CardioPerfect Workstation modules and conforms to the Microsoft UI guidelines.

Figure 4.1 Main Window

Title bar
The title bar displays the name of the program. Three buttons located on the right of the title bar can be used to maximize, minimize and close CardioPerfect Workstation.

Menu bar
The menu bar contains the File, Edit, Mail, View, Action, Tools and Help menus. When a menu is grayed out you cannot access its functionality.

Toolbar
The toolbar contains the Patient, ECG, Exercise ECG, Recollect, Spirometry, ABP, Print, and Print Preview buttons. It provides easy access to other CardioPerfect Workstation applications and most common tasks in the SpiroPerfect module.

Search area
The search area on the left hand side contains search and display functionality. In the search area, you can find a patient, see the date and type of tests recorded for a patient. You can create search patterns, so you can easily locate frequently needed information.
<table>
<thead>
<tr>
<th><strong>Workspace</strong></th>
<th>The workspace displays tests and test-related data, such as graphs and measurements. This is where you record, view and interpret the data.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The workspace is divided into three elements:</strong></td>
<td></td>
</tr>
<tr>
<td>• <strong>Graph area:</strong></td>
<td>This area displays spiromgrams and flow curves.</td>
</tr>
<tr>
<td>• <strong>Interpretation area:</strong></td>
<td>The interpretation area displays the automatic or confirmed interpretation for the test, lung age and ATS reproducibility data.</td>
</tr>
<tr>
<td>• <strong>Parameters area:</strong></td>
<td>The parameters area displays each effort and up to 6 user-defined measured parameters.</td>
</tr>
<tr>
<td><strong>Shortcut Menu</strong></td>
<td>In the workspace, you can use shortcut menus to access the most common tasks. You can access these tasks by clicking on the workspace with your right mouse button. Shortcut menus are context sensitive, meaning that they show only relevant tasks for the area clicked.</td>
</tr>
<tr>
<td><strong>Status bar</strong></td>
<td>The status bar at the bottom of the window shows the name of the user currently logged on, the patient’s race, height, weight and the Prediction norm used in the Spirometry test currently viewed.</td>
</tr>
</tbody>
</table>
5 Customizing the Spirometry Module

This chapter shows how to adjust various settings like selecting prediction schemes, determining which parameters to view and print, and set various display options.

Customize features in the Spirometry settings.

To open the Spirometry settings:
1. Choose File
2. Select Settings > Spirometry

The following screen appears:

Figure 5.1 Settings Screen

5.1 General Tab

To display the General tab:
1. Choose File
2. Select Settings > Spirometry > General

The following screen appears:
### Setting | Description
--- | ---
**Prediction** | Select the prediction to use. The list contains all supported predictions.
**VC Parameter** | VC parameters, FEV1% formula:
- The FEV1% formula determines the calculation method for the FEV1% value, which affects the automatic interpretation. The variable part of this formula is the denominator; the numerator is always the best effort’s FEV1 value.
- To determine the way in which FEV1% is calculated, choose from these options:
- FVC (FEV1% = FEV1/FVC)
- FIVC (FEV1% = FEV1/FIVC)
- Max (FVC, FIVC, SVC*) (FEV1% = FEV1/FVC or FIVC or SVC, the largest)

*Note: The SVC parameter is only included if Final Result is set to Best composite.*

**Reversibility** | Reversibility is the percentage difference between pre-test and post-test data. This measurement indicates the effect of medication on lung function. Reversibility applies to each parameter separately.
A patient's best effort is a measurement calculated from a set of efforts. To determine the method in which best effort is calculated, choose from these options:

**Best effort**
Defines **best effort** as the single best effort in a set of efforts per effort type (best FVC-pre, best FVC post, best SVC). This ATS-recommended method uses the effort with the highest sum of FVC + FEV1, or the effort with the highest SVC value. (For details, see the document noted in reference 5.)

**Best Composite**
Defines **best effort** as a composite of the highest parameter values across all selected efforts.

**Calibration syringe**
Default value for the volume of the calibration syringe. Select the **Syringe Volume** from the list.

** Calibration reminder**
Check this box to receive a calibration reminder pop-up daily, weekly or monthly.

**Pressure**
Determines the unit of Pressure. Check the preferred unit.

**Flow**
Determines the unit of Flow on the axis of the graph, possible options are L/s or L/m.

**Temperature**
Determines the unit of Temperature, possible options are °C or °F.

### 5.2 Viewing Tab

To display the Viewing tab:

1. Choose **File**
2. Select **Settings > Spirometry > Viewing**

   The following screen appears:
Figure 5.3 Spirometry Viewing tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameters in Columns or Rows</td>
<td>Changes the layout of the six parameter table.</td>
</tr>
<tr>
<td>Show Predictive Points and/or Curve</td>
<td>If Points is checked, predictive points display and print in the FVC graph, Predictive points definition see page 94. If Curve is selected a prediction curve will be displayed in the FVC graph.</td>
</tr>
<tr>
<td>Trending % Reference Value or % Predicted</td>
<td>% Reference Value or % Predicted. When % Reference Value is selected, parameters values are graphed as a percentage of the selected reference value. When % predicted is selected, parameters will trend as a percentage of predictive values.</td>
</tr>
<tr>
<td>Manual selection of best effort</td>
<td>If checked, you are allowed to manually select the best effort, when the Final Result is set to Best Effort.</td>
</tr>
<tr>
<td>Display ATS Acceptability per effort</td>
<td>If checked, a row or column appears in the Parameter and Measurement tables displaying whether or not each individual effort meets the ATS 2005 acceptability criteria.</td>
</tr>
<tr>
<td>Superimpose FV Curves</td>
<td>If checked, curves are offset on the graph. If unchecked, all curves are superimposed.</td>
</tr>
</tbody>
</table>
Display Lung Age

If checked, the estimated Lung Age will be shown while viewing a test and in the printed reports for patients of 20 years or older. For details, see Lung Age, page 70.

Effort Label

Time or Number. If Time is selected, each effort is labeled with the time it was recorded. If Number is selected, each effort is labeled with a number and stage. For example, FVC Pre3 means it is the 3rd effort of a FVC test.

X Axis Position

Bottom or Top. If Bottom is selected, spirograms are displayed with the horizontal axis at the bottom of the graph. If Top is selected spirograms are displayed with the horizontal axis at the top of the graph.

Table Color Scheme

Defines the background color and font type and color of the Spirometry module. The default setting is Welch Allyn. To customize the settings select User Defined from the drop-down menu.

Scheme Editor

Select the User Defined option from the Table Color Scheme drop-down menu. Once selected, the Scheme Editor button becomes highlighted. Click on the Scheme Editor button. The Styles properties editor dialog box appears. You can customize the properties for the Spirometry module in the Styles properties editor dialog box.

5.3 Parameters Tab

To display the Parameters tab:

1. Choose File
2. Select Settings > Spirometry > Parameters

The following screen appears:
## Figure 5.4 Spirometry Parameters tab

![Spirometry Parameters tab](image)

### Select parameters for three categories:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Measurements</strong></td>
<td>Parameters selected in the Measurements column are displayed in the Measurements Tab of the SpiroPerfect module.</td>
</tr>
<tr>
<td><strong>Six parameters</strong></td>
<td>Parameters selected in the Six parameters column are displayed in the six parameters table of the module's Parameter area. A maximum of six parameters can be selected per test type. For FVC, a minimum of three parameters is required.</td>
</tr>
<tr>
<td><strong>Printer</strong></td>
<td>Parameters selected in the Printer column are printed on the reports.</td>
</tr>
</tbody>
</table>

---

### Parameters Measured

<table>
<thead>
<tr>
<th>FVC testing</th>
<th>FVC</th>
<th>FIV1</th>
<th>FIV1%</th>
<th>FEVo.5</th>
<th>FEV1</th>
<th>FEV2</th>
<th>FEV3</th>
<th>FEV4</th>
<th>FEV5</th>
<th>FEV6</th>
<th>FEV1/FVC</th>
<th>FEV2/FVC</th>
<th>FEV5/FVC</th>
<th>FEV75</th>
<th>FEV1/FEV6</th>
<th>PEF</th>
<th>FEF0.5</th>
<th>FEF25</th>
<th>FEF50</th>
<th>FEF75</th>
<th>FEF75-85</th>
<th>PIF</th>
<th>FIF50</th>
<th>FEF50/FIF50</th>
<th>FEV1/FEV6</th>
<th>FET</th>
</tr>
</thead>
</table>
5.4 Printing Tab

A color printer is recommended for printing Spirometry reports. Printing these reports with a black and white printer can lead to confusion as it is not easy to identify which curve is a Pre and which is a Post effort.

To display the Printing tab:

1. Choose File
2. Select Settings > Spirometry > Printing

The following screen appears:
### Figure 5.5 Spirometry Printing tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default report templates</td>
<td>A list of available templates used for printing reports. To print multiple reports, select the preferred formats from the list.</td>
</tr>
<tr>
<td>Show on Report</td>
<td>Unconfirmed If checked, Unconfirmed is printed on the reports if the test is not yet confirmed.</td>
</tr>
<tr>
<td></td>
<td>Confirmed By If checked, Confirmed By is printed on the reports. It provides a space for the clinician’s signature.</td>
</tr>
<tr>
<td>Print in color</td>
<td>If checked, the spirometry reports are printed in color when using a color printer.</td>
</tr>
<tr>
<td>Graph scaling</td>
<td>Select the type of scaling (graph resizing) to use when printing volume/time curves. Fixed scale (volume 10 mm/L, time 20 mm/sec, flow 5mm/(L/s))</td>
</tr>
<tr>
<td></td>
<td>Auto scale—both x and y-axes (volume and time) scale automatically.</td>
</tr>
</tbody>
</table>
5.5 Recording Tab

To display the Recording tab:

1. Choose File
2. Select Settings > Spirometry > Recording

The following screen appears:

Figure 5.6 Spirometry Recording tab
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor Type</td>
<td>Select Welch Allyn SpiroPerfect.</td>
</tr>
<tr>
<td>Connected To</td>
<td>Welch Allyn SpiroPerfect</td>
</tr>
<tr>
<td></td>
<td>The port to which the Welch Allyn SpiroPerfect sensor is connected, is automatically detected. When operating in a thin-client environment, the application displays an additional option, called PerfectLink™. This option allows the use of the Welch Allyn SpiroPerfect sensor in thin client environments.</td>
</tr>
<tr>
<td>Calibration protocol</td>
<td>Select the Single calibration stroke protocol (this is recommended for the Welch Allyn Spiro Perfect) or Select Three calibration stroke protocol (1, 2 and 3 seconds flow)</td>
</tr>
<tr>
<td>Calibration Error Tolerance</td>
<td>Select Social Security (1%) for increased accuracy required by US Social Security Administration guidelines or Standard (3%)</td>
</tr>
<tr>
<td>Incentive file</td>
<td>Select the file that is used for the incentive screen for testing the pediatric population.</td>
</tr>
<tr>
<td>Sensor calibration information</td>
<td>Enter the Lot code and the Calibration code and Confirm. For more information see page 32. If the Spiro Perfect VCT 400 is selected this area is not applicable.</td>
</tr>
</tbody>
</table>

### 5.6 Customize the spiro.txt file

Statements used in the Comment editor can be customized. Please refer to the Workstation manual for general instructions on editing this file.

**Medication list**

In addition to the pre-defined comment and interpretation statements, this file also contains the medications shown in the medication list. These items are immediately followed by an asterisk (*) in the spiro.txt file.

*Note: If no spiro_cmt.txt file is available the spiro.txt file is used.*
6 Ambient Settings /Temperature, Humidity and Pressure

Adjust the Ambient Settings (the temperature, humidity and air pressure) before calibrating the flow sensor.

---

CAUTION

Adjust ambient settings before calibrating the flow sensor. If the ambient settings are not adjusted before calibration, the device will not be properly calibrated and could give false readings.

You must recalibrate if there is a significant change in the ambient settings.

Ambient settings are stored locally by the program and passed on to the flow sensor before each measurement. This means that when using different PC's with the same flow sensor you have to set the ambient settings on each PC before starting the measurements. Also, when another person logs in to the PC, he/she needs to enter the ambient settings.

---

6.1 Why the Workstation needs Ambient Setting Information

Ambient settings information is necessary for calculating the Ambient Temperature Pressure Saturation (ATPS) to Body Temperature Pressure Saturation (BTPS) correction in the Flow sensor.

6.2 When to Adjust the Ambient Settings

Adjust the ambient settings:
- Daily, the first time logging into the Spirometry module.
- When ambient settings have changed significantly during the day.
- When the same flow sensor is used on different computers. In this case, adjust the ambient settings on each computer.
- Before a calibration takes place, in the pre-calibration window.

6.3 Adjusting the Ambient Settings

1. Make sure the SpiroPerfect module is loaded.
2. Press F9 or choose Ambient settings from the Tools menu.

The following screen appears:
Figure 6.1 The Ambient settings dialog box

<table>
<thead>
<tr>
<th>Ambient settings</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>80 °C</td>
</tr>
<tr>
<td>Humidity</td>
<td>60 %</td>
</tr>
<tr>
<td>Pressure</td>
<td>1040 mbar</td>
</tr>
</tbody>
</table>

1. Enter the Temperature value. (The value for the ambient temperature.)
2. Enter the Humidity value. (The value for the ambient air humidity.)
3. Enter the Pressure value. (The value for the ambient barometric pressure.)

**Tip:**
In the spirometry settings, the ambient units for temperature and pressure can be changed.

**Tip:**
There is an additional option available to update the Ambient settings:
1. Select Calibrate located on the Toolbar (or press F10)
2. Enter the ambient setting information in the Pre-Calibration dialog box. Updating ambient settings is recommended when a calibration is going to be performed.
7 Calibration of Flow Sensor

CAUTION The American Thoracic Society and Welch Allyn recommend calibrating spirometers every day before use

Welch Allyn guarantees accurate calibration only with the use of a Welch Allyn 3L calibration syringe. Although SpiroPerfect provides other calibration syringe volumes for use, Welch Allyn is not responsible for the system’s accuracy if these syringes are used.

Flow Transducers
Flow Transducers are manufactured to high precision and it is not necessary to calibrate the spirometer system with each Flow Transducer separately.

CAUTION Consult Accompanying Documents
Perform a new calibration when using a new lot of Flow Transducers.

7.1 Preparing calibration

Calibration Protocol
SpiroPerfect supports two calibration protocols:
- Single Stroke Calibration
- Three Stroke Calibration

The calibration protocol can be set on the Recording tab in the Spirometry Settings. See section 5.5 Recording Tab.

To calibrate the Welch Allyn SpiroPerfect flow sensor it is strongly recommended to use the Single Stroke Calibration Protocol while calibrating. This method will increase the accuracy of the flow sensor. To calibrate the Spiro Perfect VCT-400 use the Three Stroke Calibration Protocol for the best results. The protocol can be changed in the spirometry settings.

Warm up the Spirometer
Before calibrating it is recommended to let the Spirometer warm up. If the Spirometer has already been used shortly before calibration, this warm up period is not needed.

1. Connect the Spirometer to the computer.
2. Open the Spiro module.
   - The sensor starts to warm up as soon as the spirometer module is opened.
3. Wait for at least 5 minutes before starting the calibration process.

7.2 The Calibration Process

Make sure the Spirometer is plugged in before continuing.

1. To start the calibration, select the Calibrate button located on the Toolbar (or press F10). The following dialog box will be presented to configure the calibration process.
Figure 7.1 The Pre-calibration dialog box

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lot code</td>
<td>Enter the Lot code for the Flow transducers located on the box the Transducers came in.</td>
</tr>
<tr>
<td>Calibration code</td>
<td>Enter the Calibration code for the Flow transducers located on the box the Transducers came in. See example of a schematic cutout of the label from the Flow transducers box below.</td>
</tr>
<tr>
<td>Syringe Volume</td>
<td>Select the appropriate Syringe Volume.</td>
</tr>
<tr>
<td>Current Calibration Factor</td>
<td>This value cannot be changed and indicates the correction factor applied to the calibration data from the previous session. Once the calibration is performed, this value will be updated. The factor displayed is the average of the inspiration and expiration calibration factor.</td>
</tr>
<tr>
<td>Calibration Error Tolerance</td>
<td>Select the measured calibration accuracy to be within 1% or 3% of the syringe volume.</td>
</tr>
</tbody>
</table>

Note: the sensor calibration information can also be set in the Spirometry settings (recording tab). Please make sure that Lot code and Calibration code are still accurate before calibrating.

Fill in the appropriate settings. For a description of the options see the following table.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tip: See page 28 on how to change the default setting.</td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>The ambient temperature. See Operating Environment Specifications on page 80</td>
</tr>
<tr>
<td>Humidity</td>
<td>The ambient humidity. See Operating Environment Specifications on page 80</td>
</tr>
<tr>
<td>Pressure</td>
<td>The ambient pressure. See Operating Environment Specifications on page 80</td>
</tr>
</tbody>
</table>

### WARNING
For the ambient settings pressure field please enter the pressure as given by a barometer in the immediate vicinity. **Do not enter the normalized sea-level pressure as commonly listed on internet sites on meteorological data resources.**

2. Press the Next button to continue.

The following screen appears depending on your setup:

**Figure 7.2 Calibration window**

Beneath the Calibration window the calibration instruction and message window is displayed, giving instruction for the calibration procedure.

**Note:** Please check the calibration and lot code if you cannot continue to the Calibration window.

3. Connect the syringe to the new flow transducer.
4. Fill the syringe by pulling the plunger completely out.
5. Press the Calibrate button in the window.
6. Wait until the messages ‘Initializing sensor. Opening sensor, please wait...’ disappears.
7. Verify the syringe is completely filled and press the OK button. 
   **Note:** If the syringe was emptied before calibration, the “No valid stroke recorded” message will appear.

8. Follow the instruction on screen. The blue calibration bar can be used as a guide line by giving you an indication of the speed.

**Figure 7.4 Calibration bar**

For a single flow calibration protocol
Push the plunger entirely in and pull the plunger out as far as possible, while following the blue bar as closely as possible. The calibration procedure will stop automatically, and inform you of the results.

For multiple-stroke calibrations
Push the plunger entirely in and pull the plunger out as far as possible, three times, while following the blue bar as closely as possible.

At the end of each stroke a message appears; you can either choose to accept the calibration stroke or redo the last stroke.
The following options apply:

- **Yes:** Continue to the next stroke, or show calibration results.
- **No:** Redo the current stroke with the same speed.
- **Cancel:** Stop calibrating. The sensor will not be calibrated.

9. If the calibration was successful this will be displayed. You can either accept the results or recalibrate. If the ATS standard has not been met you have to recalibrate.

- See the following section on how to deal with the results.
- If you have pressed the Recalibrate button: Press the Repeat Calibration button in the Calibration window and follow the instructions above from step 6.

**Note:** *If you have trouble getting the results within the Calibration Error Tolerance try:*

- waiting 1 second between emptying and filling the syringe.
- a single flow calibration before the three flow calibration, if the three flow calibration is unsuccessful.
7.3 View Calibration Results

After calibration the Verify Calibration Results window will appear.

Figure 7.6 Verify Calibration Results

Each row gives the result of a stroke, the last row gives the Averages. The following columns are given:

<table>
<thead>
<tr>
<th>L/s</th>
<th>Results per stroke:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The speed in the L/s plunger should be moved, as indicated by the blue calibration bar during the strokes.</td>
</tr>
<tr>
<td>Exp. Vol</td>
<td>The expiration volume reached by pushing in the plunger.</td>
</tr>
<tr>
<td>Exp.%</td>
<td>The expiration deviation from the actual volume in percent.</td>
</tr>
<tr>
<td>Insp. Vol</td>
<td>The inspiration volume reached by pulling out the plunger.</td>
</tr>
<tr>
<td>Insp.%</td>
<td>The inspiration deviation percentage</td>
</tr>
<tr>
<td>Avg.Vol</td>
<td>The averages of inspiration volume and expiration volume.</td>
</tr>
<tr>
<td>Abs.Avg.%</td>
<td>The absolute average deviation percentage between inspiration volume and expiration volume.</td>
</tr>
</tbody>
</table>

The Averages row gives the averages reached for all strokes. Please refer to this row for improving the calibration results.

After you have accepted the results you can view these values in the table below the graph by selecting the Calibrate Results button.

Note:
Abs.Avg% should be:
- <1% to meet the social security standard
- <3% to meet ATS standard

\[
(|\text{Exp.} \%| + |\text{Insp.} \%|)/2 = \text{Abs.Avg.}\%
\]
Figure 7.7 Single stroke calibration window with calibrated results

![Single stroke calibration window with calibrated results](image)

**Calibrated results table:**

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibrate</td>
<td>Press the &quot;Calibrate&quot; icon when you are ready to start the calibration process. After one calibration, the icon label changes to 'Repeat Calibration'. It is recommended to repeat the calibration more than once.</td>
</tr>
<tr>
<td>Calibration Results</td>
<td>Press the Calibration Results icon to view the results of the calibration. This can only be viewed between calibration attempts.</td>
</tr>
<tr>
<td>Calibration Logs</td>
<td>Press the Calibration Logs icon to view previous calibration attempts.</td>
</tr>
<tr>
<td>Print Log</td>
<td>Press Print log icon to print the currently selected or displayed log.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Press Print Preview. The Print dialog box appears. Press OK on the Print dialog box to view the calibration results before printing.</td>
</tr>
<tr>
<td>Done</td>
<td>Press Done to exit the Calibration window.</td>
</tr>
</tbody>
</table>

7.4 Error Messages Associated with Failed Calibration

Figure 7.9 No valid stroke recorded

![Warning](image)

When the calibration attempt was not valid or if the volume read back by the sensor is not within 35% of the selected syringe volume, the calibration fails. This message also appears if the calibration attempt was performed in the wrong order, first emptying the syringe instead of filling it before starting the calibration.
Caution  It is the user’s responsibility to determine whether to accept or reject failed calibration data. If the device does not pass calibration it could give false readings.

7.5 Calibration log

Figure 7.11 Calibration log window

Use the Calibration log to view calibration information of current and previous calibration efforts. Each time the sensor is calibrated, results are stored in the calibration log. Select a calibration effort from the list to see the curve that belongs to it.

Calibration Log

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date &amp; time</td>
<td>Date and time of the calibration.</td>
</tr>
<tr>
<td>User</td>
<td>Name of the user that performed the calibration.</td>
</tr>
<tr>
<td>Location</td>
<td>Location specified in the general settings.</td>
</tr>
<tr>
<td>Device ID</td>
<td>The spirometry sensor hardware used.</td>
</tr>
<tr>
<td>Insp. CF</td>
<td>The Calibration Factor of the inspiratory strokes.</td>
</tr>
<tr>
<td>Insp. SD</td>
<td>The stroke difference between the inspiratory strokes.</td>
</tr>
<tr>
<td>Exp. CF</td>
<td>The Calibration Factor of the expiratory strokes.</td>
</tr>
<tr>
<td>Exp. SD</td>
<td>The stroke difference between the expiratory strokes.</td>
</tr>
<tr>
<td>Calibrated</td>
<td>A check mark shows if the sensor was actually calibrated (yes) or only a log entry was saved (no).</td>
</tr>
</tbody>
</table>

To view the calibration log:
1. Choose Tools
2. Select Calibration log
8 Recording Spirometry Tests

Various types of efforts can be recorded with the Spirometer module:
- **FVC**: Forced Vital Capacity.
- **MVV**: Maximum Voluntary Ventilation.
- **SVC**: Slow Vital Capacity.

The following tags can be assigned to each effort:
- Pre
- Post

When recording a post stage effort the medication administered to the patient can be entered.

8.1 Record a Spirometry Test

Follow these steps to record a test.

1. In the Workstation, find or create a patient (see the Workstation manual for instructions).

2. Choose Spirometry, located in the toolbar at the top of the screen.

**Tip:**
The following screen appears if a new effort or test is being added to the patient’s profile within 24 hours since the last test or effort.

**Figure 8.1 Warning window**

![Warning window]

**Caution**
Use numerals only to set the date format. Alpha characters cannot be used in the date field.
3. Complete Patient information fields in the New spirometry test window. Check the Smoker and/or Asthmatic boxes if applicable.

4. Select the Specialty and Referring physician, by whom the test was ordered.

5. Select the Prediction Norm for the test.

**Caution**
To obtain predictive values for certain parameters, the patient’s age, gender, race and height must be entered into the Patientcard dialog box (Choose Edit-patientcard or Alt+P), otherwise no predictive data is reported. The patient’s weight is only obligatory for certain prediction norms.

**Note:** If patient data is missing these will be displayed in red in the New spirometry test window. You must fill in the blanks before you are able to continue.

The Norm Profiles (see section 12.1) indicate valid demographic ranges for each norm.

6. Select Ambient Settings. If the humidity, temperature or pressure have changed since the last calibration, adjust as necessary.
7. Select Next

The following screen appears:

**Figure 8.3 Recording window**

![Recording window image]

**Tip:**
Double click on the left graphic to expand it to full window size. Double click again to reduce it to half window size.

8. Select the effort type to perform by selecting the FVC, SVC or MVV.

9. Select the effort stage. If you have selected Post, enter the medication dosage and unit.

   **Note:** The medication and dosage fields are only active if a post-effort is selected. Post-effort is only available after a pre-effort has been recorded.

10. Select the type of curve from the drop-down menu located at the bottom of the right graph.

**Figure 8.4 Type of Curve menu**

```markdown
<table>
<thead>
<tr>
<th>Volume/Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume/Time</td>
</tr>
<tr>
<td>Flow/Time</td>
</tr>
<tr>
<td>Incentive</td>
</tr>
</tbody>
</table>
```

11. Instruct the patient to hold the SpiroPerfect sensor still.

   **Note:** Make sure the rear of the flow-tube is not blocked. The extra resistance will result in faulty measurements.

12. Select Record to start recording.

13. Ask the patient to perform the effort according to the appropriate procedures. See section 8.3.

14. When the patient has completed the test, select Done. The recording window closes and the main view displays all efforts of the recorded effort stage (Pre/Post).

   **Note:** The effort along with six corresponding parameter values are displayed in the parameters area.
15. The status bar of the Recording window displays, ATS acceptability criteria met, duration of the effort, number of FVC, SVC and MVV efforts completed in a test and if the reproducibility criteria are met.

16. When the patient finishes testing, select Done. The Spirometry view appears displaying all the efforts.

### 8.2 Incentive Screen

The incentive screen is used to encourage pediatric patients to blow into the flow transducer the best they can.

**Note:** If the patient’s demographics are outside of the Prediction norm demographics no prediction values will be calculated. The incentive screen will not operate without predicted values.

**To display the Incentive screen:**
Select the Incentive button from the Recording/Test toolbar

*or*

Select Incentive from the Type of Curve drop-down menu

The following screen appears

**Figure 8.5 Recording window with incentive screen selection**

**Note:** Incentive screen
The fireman extinguishes the fire if the patient’s effort reaches 80% of the predicted for PEF & FVC values. If the patient’s effort is below 80%, the fire is not extinguished.

**To remove the Incentive screen:**
Select Volume/Time or Flow/Time from the Type of Curve drop-down menu or select the FVC, SVC or MVV button.
8.3 Patient Procedures

![WARNING]

Patients may become faint, light-headed, dizzy, or short of breath during spirometry testing. Watch patients closely. If they choose to stand during testing, keep a chair immediately behind them. If there is any reason for concern, stop the test and take proper action.

**Recommendations**
- Practice the procedure with the patient before recording the effort.
- American Thoracic Society recommends ending recording after eight successful FVC efforts to avoid fainting.

To prepare patients for any spirometry test, explain the entire procedure for the type of effort you want them to perform. Remind patients that the test is painless. Demonstrate at least one effort for the patient.

The accuracy of a spirometry test is highly dependent on the patient’s understanding and cooperation. So, be prepared to coach and encourage the patient with your “body language” and your words — for example, “Blow, blow, blow, keep blowing until you can’t blow out any more” — to ensure a good effort with reproducible results.

**Instruct patients to do the following:**

- Loosen any tight articles of clothing that might constrict lung function, for example, a tight belt, tie, vest, bra, girdle, or corset.
- Remove any foreign objects from the mouth, including loose dentures.
- The use of a nose clip is highly recommended. If used, check for proper fit.
- Place lips and teeth around a new flow transducer, sealing their lips tightly around the transducer. Grip slightly with teeth in the groove.
- Keep tongue away from the flow transducer to avoid blocking it.
- Keep the rear of the Flow sensor free.
- Keep chin up so as not to restrict the airway.

![WARNING]

Always check the interior of the flow transducer to ensure that no foreign objects are present.

Once the patients have the flow transducer in place, ask them to perform the effort using the guide below for the patients’ predicted performance effort breathing instructions.

*Note:* Place the mouthpiece in the patient’s mouth after stabilization.
For an FVC effort, instruct the patient to:
1. Breathe in (until the Total Lung Capacity is reached).
2. Blow out forcefully (until the Residual Volume is reached). Allow sufficient time.

For an FVC loop, instruct the patient to:
1. Breathe in (until the Total Lung Capacity is reached).
2. Exhale forcefully (until the Residual Volume is reached)
3. Breathe in forcefully (until the Total Lung Capacity is reached). Allow sufficient time.
   -or-
   1. Start normal breathing (tidal breathing).
   2. Breathe out (until the Residual Volume is reached).
   4. Exhale forcefully (until the Total Lung Capacity is reached).

For an SVC effort, instruct the patient to:
1. Start normal breathing (tidal breathing).
2. Breathe in calmly, (until the Total Lung Capacity is reached).
4. If necessary, repeat steps 3 and 4.
   Steps 3 & 4 can be reversed, meaning: a maximum expiration followed by a maximum inspiration.

For an MVV effort, instruct the patient to:
Breathe in and out forcefully at a pace of approximate 30 breaths per minute (2 seconds per complete breath) for 15 seconds (the program automatically stops gathering data after 15 seconds).

About Quality Feedback
The spirometer provides effort-quality messages as described in the following sections.

About Effort-Quality Messages
One of the following effort-quality messages appears on the screen after each effort is completed. These messages indicate whether an effort was acceptable, and if not, what the patient needs to do differently.

<table>
<thead>
<tr>
<th>Effort-Quality Message</th>
<th>Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>Don’t hesitate</td>
<td>Back Extrapolated Volume (BEV) is &gt; 150 mL</td>
</tr>
<tr>
<td>Blast out faster</td>
<td>PEF time &gt; 120 ms.</td>
</tr>
<tr>
<td>Blow out longer, No plateau</td>
<td>FET &lt; 6 seconds (3 pediatrics) and no plateau</td>
</tr>
<tr>
<td>Good effort</td>
<td>FET &lt; 6 seconds (3 pediatrics) and has plateau OR FET is &gt; 6 seconds (3 seconds pediatrics)</td>
</tr>
</tbody>
</table>

8.4 Deleting an Effort
You can easily delete an effort after recording it.

To delete an effort:
Option 1: In the Recording Test window
1. Select Delete

   The following screen appears

   **Figure 8.6 Confirmation dialog box**

   ![Confirmation dialog box](image)

   Are you sure you want to delete the current effort?

   OK  |  Cancel

2. Select Ok

Option 2: While viewing the test
Highlight the effort to delete in the Parameters area, located in the lower right side of the workspace window. See Figure 4.1 Main Window

1. Select Action> Delete Effort or Ctrl+D, located on the menu bar, the confirmation dialog box appears. See Figure 8.6.
2. Select OK

### 8.5 Add or Change Information in the Comment Editor

When creating a new spirometry test, the SpiroPerfect offers space for adding or changing comments, while recording.

**To add or change comments:**
1. Choose Patient, and start a new Spirometry test
2. Select Next
3. Select the Comment button from the toolbar.

   **Note:** The Comment editor is displayed containing previously added comments.
4. Select interpretations and or medication from the statement tree on the left side, or type in comments in the comment pane.
5. Select Save
   The Recording/Test window will appear again.

The comment editor is also available form the menu bar, select Edit comment from the Action menu or type CTRL+T.
9 Viewing Spirometry tests

9.1 View a Spirometry test

To view a spirometry test:
1. Select a patient. The patient’s previously recorded tests appear in the test list.
2. From the test list, select a spirometry test to view.
   Note: Spirometry tests are indicated with a 🩸.
3. SpiroPerfect launches and the test is displayed in the workspace.
4. Use the tabs and the Effort selector (in the toolbar) for selecting information to view.

9.2 Setting the Best Effort

Follow these steps for setting the Best Effort:
1. Choose File
2. Select Settings > Spirometry
3. Select the General tab
4. Under the Final result, check Best effort
5. Select the Viewing tab
6. Check Manual selection of the best effort
   Note: This action is not available if “Best composite” is set as Final result in the Spirometry General Settings.
7. Select Ok. The Spirometry settings window closes
8. Set the effort selector to Pre or Post, see Figure 9.4. This feature will not function if you have selected All Efforts or Final Results.

   All Efforts: view and compare all efforts of current test.

   Pre: view and compare only the pre efforts of current test.

   Post: view and compare only post efforts of current test.

   Final/Best result: view and compare only the best effort/ final result of current test.

9. Select the pre effort you consider best.
10. Next, from the menu bar, select Action> Set Current Effort As Best
11. Repeat steps 8-10 for the post effort selection.

9.3 View and Add Information to a Test

To view and/or add information to a test:
- Select Tools > Information

The following screen appears

Figure 9.3 Information dialog box

To enter comments:
1. Type comments in the Comment section
2. Select OK

9.4 Test Modes and Tabs

There are four views available from the Effort selector in the toolbar:

All Efforts: view and compare all efforts of current test.
Pre: view and compare only the pre efforts of current test.
Post: view and compare only post
Final/Best result: view and compare only the best effort/ final result of current test.

Figure 9.5 Five tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FVC</td>
<td>Select to view only the currently selected FVC efforts. A flow/volume curve of the current FVC effort and the flow/volume curves of all selected FVC efforts. The dotted line marks the predicted values.</td>
</tr>
<tr>
<td>SVC</td>
<td>Select to view only the currently selected SVC efforts. A spirogram for the current SVC effort.</td>
</tr>
<tr>
<td>MVV</td>
<td>Select to view only the currently selected MVV efforts. A spirogram for the current MVV effort.</td>
</tr>
<tr>
<td>Trend</td>
<td>Select to view only the trends to a maximum of six parameters. Trends of the FVC effort of the test.</td>
</tr>
<tr>
<td>Measures</td>
<td>Select to view all the parameters calculated of all effort types. All parameters values based on user settings for each stage and effort.</td>
</tr>
</tbody>
</table>
9.5 Common Features for each Tab

Figure 9.6 Tab overview

View multiple flow/volume curves of one test

It is possible to view and compare multiple efforts previously recorded in one test. The right hand side of the window displays a flow curve of all selected efforts. The left hand side of the window displays the flow curve of the currently selected effort.

To view multiple efforts in one flow/volume graph:

1. In the Spirometer window, move the mouse arrow to the Parameters table.
2. Check the box of each effort to view in the Selected row/column.
3. Uncheck the boxes of each effort to hide it from view.
9.5.1 Parameters Area

Figure 9.7 Parameters Table

<table>
<thead>
<tr>
<th>Effort</th>
<th>Units</th>
<th>GLI 2012 (LLN)</th>
<th>Pre 2</th>
<th>Pre 1</th>
<th>Final</th>
<th>FinalPred [z]</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATS</td>
<td></td>
<td></td>
<td>No</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Selected</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FVC</td>
<td>L</td>
<td>5.71 (4.58)</td>
<td>5.60</td>
<td>5.13</td>
<td>5.60</td>
<td>98 % (0.16)</td>
</tr>
<tr>
<td>FEV1</td>
<td>L</td>
<td>4.65 (3.70)</td>
<td>4.70</td>
<td>4.34</td>
<td>4.70</td>
<td>101 % (0.08)</td>
</tr>
<tr>
<td>FEV1/FVC</td>
<td>%</td>
<td>82 (%)</td>
<td>94 %</td>
<td>85 %</td>
<td>94 %</td>
<td>102 % (0.35)</td>
</tr>
<tr>
<td>FEV6</td>
<td>L</td>
<td>-</td>
<td>5.60</td>
<td>5.13</td>
<td>5.60</td>
<td>-</td>
</tr>
<tr>
<td>PEF</td>
<td>L/s</td>
<td>11.14</td>
<td>10.96</td>
<td>11.14</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>FEF25-75</td>
<td>L/s</td>
<td>4.61 (2.92)</td>
<td>5.06</td>
<td>4.94</td>
<td>5.06</td>
<td>110 % (0.36)</td>
</tr>
</tbody>
</table>

Selection Parameters area

Description
The Parameters area holds the parameters table. It is displayed under the FVC, SVC MVV and Trend tabs.

The Parameters table lists up to six user-defined parameters. See page 24 to select the parameters.

The following information is displayed in the table:
- predictive norm
- ATS acceptability criteria
- predictive values per parameter, followed by the lower limit of normal in parentheses
- effort stage & parameter value
- final result parameter values
- % predictive, followed by the z-score in parentheses for the norms that support z-score
- % change (in “All efforts” and “Post” view)

Effort
The color in front of the effort name corresponds to the color of the curve in the graph.

Select the check box in the selected row or column and the curve is displayed in the graph. You can select to show the parameters in rows or columns in the settings menu > viewing tab, see page 22.

Deselect a check box and the curve is hidden.

9.5.2 Interpretation Area

The interpretation area displays automatic or confirmed interpretation, medications, comments, lung age (if enabled in the settings), and reproducibility information. See page 59 for more information.
Figure 9.8 Interpretation Area

Interpretation:
Pre-FVC= 5.50L, FEV1 = 4.70L, FEV1/FVC = 83.90%
(2/3/2000 4:15:12 PM), Within normal limits

Interpretation Not Confirmed

Comment:
8-2-00 16:18

Lung Age:
35 years

9.6 FVC Tab

Figure 9.9 FVC Tab

<table>
<thead>
<tr>
<th>Left Graph</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The left graph always represents the selected effort in the parameters table as a flow volume loop or as tidal volume.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Right Graph</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The right graph displays curves all efforts selected for a particular stage. Different curve views are selected from the drop down menu:</td>
<td></td>
</tr>
<tr>
<td>• Flow/Volume</td>
<td></td>
</tr>
<tr>
<td>• Volume/Time</td>
<td></td>
</tr>
<tr>
<td>• Flow/Time</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Axes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In a flow volume graph, the flow is plotted against the volume. In a volume/time graph, the volume is plotted against time.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Units</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Volume is expressed in liters.</td>
<td></td>
</tr>
<tr>
<td>• Time is expressed in seconds.</td>
<td></td>
</tr>
<tr>
<td>• Flow is expressed in liters per second, or liters per minute based on settings.</td>
<td></td>
</tr>
</tbody>
</table>
9.7 SVC Tab

Figure 9.10 SVC Tab

SVC Test
Review results under the SVC tab. Only volume/time (spirogram) graphs are displayed along with six SVC parameters.

Calipers mark the beginning and the end of the tidal area. Each effort line displayed on the graph has a different color.

**Note:** Calipers can be manually adjusted. If so, affected parameters will automatically be recalculated.

If no SVC test is performed, the SVC tab is disabled.
9.8 MVV Tab

Figure 9.11 MVV Tab

MVV Test
Review the results under the MVV tab. Only volume/time (spirogram) graphs are displayed along with six MVV parameters.

Calipers (vertical lines) mark the beginning and the end of the ventilation volume (not the tidal area).

Note: Calipers can be manually adjusted. If so, affected parameters will automatically be recalculated.

Tip: You can select or deselect a curve in the parameters table.

If no MVV test is performed, the MVV tab is disabled.
9.9 Trend Tab

Figure 9.12 Trend Tab

The Trends tab displays trends of:

- the FVC efforts of the test or
- the best pre and best post efforts of the several different tests of the same patient.

There is no limit to the number of tests that you can trend. You can simultaneously view three parameters and see how the parameters evolve during the test.

The interpretation area shows the interpretation of the most recent test.

Figure 9.13 Parameters menus

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameters</td>
<td>Three parameters are always trended. The choice of parameters trended depends on the selected parameters in the settings (File&gt; Settings&gt; Spirometry&gt; Parameters tab&gt; Six parameter column). When you exit the trend view, SpiroPerfect remembers the last three parameters selected and recalls them when you enter the trend view again.</td>
</tr>
</tbody>
</table>
| Axes | The horizontal axis displays the date & time of the efforts. The vertical axis displays the parameter values:  
- As a % of Predictive (effort x/pred value) x 100.  
- As a percentage of a reference value. The value of the parameters is a relative value. It depends on the currently selected effort. For example, if a test has three efforts and effort 1 is selected, all parameter values for effort 1 are set to 100%. The values for other efforts are expressed as lower or higher percentages in relation to effort 1. (Effort x / Effort 1) x 100. |

Example with Effort 1 currently selected

<table>
<thead>
<tr>
<th></th>
<th>Effort 1</th>
<th>Effort 2</th>
<th>Effort 3</th>
<th>Effort 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real value of FEV1%</td>
<td>3.49</td>
<td>3.70</td>
<td>3.77</td>
<td>3.46</td>
</tr>
<tr>
<td>Relative value of FEV1% as displayed in trends</td>
<td>100%</td>
<td>106%</td>
<td>108%</td>
<td>99%</td>
</tr>
</tbody>
</table>
To view trends:

1. Select three parameters from the drop down menus located beneath the Trends graph. The curve for these parameters is displayed in the Trends graph.

2. Select or deselect efforts by checking the boxes beneath the efforts listed in the parameters area. The efforts are added or removed from the Trends graph.

3. Select which effort is used as the reference point, by clicking on one of the efforts located in the parameters area. The parameter value of this effort is set to 100% in the Trend graph, and the parameter values of all other efforts are expressed as a percentage proportional to the reference value. The percentage of deviation is given in the parameters area.

4. You can select a line from the Trends graph by clicking on one of the points in the line. The percentage deviation for each point is shown when you move the mouse over a point in the line. By clicking on a different colored point you select the line of that color and the percentage deviation for that line is displayed when moving over the points of that line.

### 9.10 Measurements Tab

| Effector | PVC Pre 1 | PVC Pre 2 | PVC Pre 3 | PVC Pre 4 | PVC Post 1 | Final | FinalRef
|----------|-----------|-----------|-----------|-----------|-----------|-------|-----------
| ATS      | No        | No        | No        | No        | No        | -     | -         |
| PVC      | 2.19      | 2.51      | 2.39      | 2.30      | 2.19      | 2.19  | 62 %      |
| TVC1     | 0.91      | 0.96      | 0.95      | 0.95      | 0.91      | 0.91  | 98 %      |
| IC       | 56%       | 56%       | 55%       | 54%       | 56%       | 56%   | 85 %      |
| ERV      | 2.39      | 2.39      | 2.37      | 2.38      | 2.39      | 2.39  | 100%      |
| MxV      | 0.93      | 0.94      | 0.94      | 0.94      | 0.93      | 0.93  | 98%       |
| MxR      | 0.93      | 0.94      | 0.94      | 0.94      | 0.93      | 0.93  | 98%       |
| SNC      | 1.61      | 1.24      | 1.05      | 1.78      | 0.79      | 1.78  | 112%      |
The Measurements Tab contains a number of parameter values for each FVC, SVC and MVV efforts. Each effort is represented by a separate column.

- The measurement table only displays the efforts belonging to the selected stage. It only lists the parameters selected in the settings. See page 24 to select parameters for display in the Measurement table.

- Information on test reproducibility is displayed in the reproducibility table that is placed below the Measurements Table. In particular, the FVC and FEV1 absolute value variance (difference) between the best effort and the second best effort is analyzed for both pre and post tests.

- When a value is in **bold red text**, that value is below the lower prediction limit.

### 9.11 Compare Tests

With SpiroPerfect, you can compare final results from different tests recorded for the same patient.

**Selecting various tests**

1. Choose Action
2. Select Comparison

The following screen appears

**Figure 9.16 Comparison dialog box**

Click on the check box in front of each test to select tests. The best pre and best post efforts of the patient’s selected tests are compared.

**Available views are:**

- FVC
- Measurements
- Trend
  The trend view displays a graphical overview of the patient’s performance over time.
10 Interpreting Spirometry Tests

The Spirometer module can automatically interpret FVC efforts.

WARNING A computer generated interpretation cannot replace sound medical reasoning by a trained professional. Therefore, a physician should always review the interpretation.

10.1 Editing and Confirming an Interpretation

Figure 10.1 Interpretation editor

In the Interpretation editor, text or interpretation statements are added to the interpretation area. Once an interpretation is edited, confirm it. Otherwise, the edits are not saved.

Opening the interpretation editor
- Choose Tools and select Interpretation.
- Select Interpretation on the Toolbar, see Figure 4.1 Main Window

Automatically generated interpretation:
The generated interpretation is shown in the interpretation editor automatically if the interpretation is unconfirmed. You can keep this interpretation and add text to it or replace it. The automatic interpretation statements can be inserted by clicking the Best effort FVC interpretation button.

Confirming an interpretation and closing the interpretation editor:
Select Confirm to save your comments and to return to the spirometry window.

Adding comments to the interpretation
Click in the comment pane and start typing the comment.

Adding text to the interpretation edit area
Click in the interpretation edit area and start typing the text.
Adding an interpretation statement to the interpretation edit area using the statement tree

1. Select a category to display the statements.
2. In the statement tree look up the statement to include in the interpretation.
3. Click on the statement to add it to the interpretation edit area.

Deleting an interpretation statement from the interpretation edit area
Select the statement text and press BACKSPACE or DEL to delete it.

Deleting a comment from the comment pane
Select the comment and press BACKSPACE or DEL to delete it.

Tips for editing and confirming an interpretation
- Automatically insert the current date and time by selecting the Date/time button.
- Clear the interpretation editor by selecting the Clear button.
- The statement tree can be changed. Please consult your system administrator or local dealer for new or changed statements.

10.2 Automatic Interpretation

The spirometer module automatically calculates interpretive results as described in the document noted in reference 2 on page 74.

The automatic interpretation is shown in the interpretation area if the interpretation is not confirmed. If the interpretation is confirmed the confirmed interpretation is shown in the interpretation area.

10.3 View Interpretation History

When making changes in an interpretation, the original interpretation is not changed, but a new one is created. A copy of all interpretations is kept in the interpretation history.

Figure 10.2 Interpretation History screen

To view the interpretation history:
1. Choose Tools
2. Select Interpretation history. The Interpretation history window is displayed. The left hand pane displays the interpretations sorted by date. The right hand pane
10.4 Reanalyze a Spirometry Test

Retrieve overwritten automatic interpretations by reanalyzing the spirometry test.

**To reanalyze a spirometry test:**
- Choose Actions
- Select Reanalyze test.

Reanalyzing the test will result in the following:
- A new interpretation is appended to the test containing the automatic interpretation statements.
- The state of the interpretation is set to unconfirmed.
- All parameter values are re-calculated.

10.5 Recalculate prediction

With this option you can re-calculate the predicted values for the test with a different Prediction norm.

**To recalculate a prediction:**
1. Go to the Action menu
2. Select Recalculate Prediction.
3. Select the preferred Prediction norm from the list.

   **Note:** for a more elaborate description of the Prediction norms see section Norm Profiles 12.1.

4. Press the OK button.
11 Printing Spirometry tests

11.1 Printing reports

To print a particular report for the test currently on your screen:

- Select File > Print
- Press Ctrl+P

The Print dialog box appears:

To print multiple reports for the test currently on your screen:

- Select File > Print selected formats
- Press Ctrl+Alt+P

To control which reports will be printed, see page 26.
11.2 Print Report Formats

The SpiroPerfect module prints the following report formats:
- All plus best effort FVC
- Best FVC
- Best MVV
- Best SVC
- Best Three FVC
- Measurements MVV
- Measurements SVC
- Measurements FVC
- Social Security
- Trend

Each format contains the patient's personal information, test information, interpretation, parameter table and all but the measurement report contain a graphs section. Please refer to the Workstation manual for further information on printing a test.

11.3 Print Preview

To Preview a Test
- Select File > Print Preview. The print dialog box appears. See Figure 11.1.
- Select type of report to preview.
  The name of the report type appears at the top of the dialog box.

The print preview window appears.

Figure 11.2 Print preview dialog box
### 11.4 Print Report Details

#### Example Report

**Welch Allyn CardioPerfect Workstation**

**Normal Spirometry Report**

- **Test Information:**
  - Date: 11/15/2007
  - Time: 11:59 AM
  - Page: 1

**Patient Information:**

- **ID:** CCM 118
- **Name:** Normal Spirometry
- **DOB:** 9/12/1933
- **Age:** 74 years
- **Height:** 63 inch
- **Weight:** 186 lbs
- **Gender:** Female
- **Race:** Caucasian
- **Smoker:** Present

**Test Results:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Pre (L)</th>
<th>Post (L)</th>
<th>%Gain</th>
<th>%Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>FVC</td>
<td>2.92 (1.45)</td>
<td>2.07</td>
<td>102% (0.03)</td>
<td>3% (-0.07)</td>
</tr>
<tr>
<td>FEV1</td>
<td>1.99 (1.45)</td>
<td>1.20</td>
<td>102% (0.03)</td>
<td>3% (-0.07)</td>
</tr>
<tr>
<td>FEV1/FVC</td>
<td>78% (0.64)</td>
<td>76% (0.64)</td>
<td>103% (0.21)</td>
<td>2% (0.21)</td>
</tr>
<tr>
<td>PEFR (%)</td>
<td>7.91</td>
<td>7.13</td>
<td>103% (0.05)</td>
<td>0% (0.01)</td>
</tr>
</tbody>
</table>

**Test Interpretation:** UNCONFIRMED REPORT

**ATG Reproducibility:**
- Pre: NOT MET (< 3 acceptable efforts)
- Post: NOT MET (< 3 acceptable efforts)

**Test Comment:**

---

**Graphs:**

- Graph 1: Effort 7 (Post) vs. Effort 4 (Pre)
- Graph 2: Vmax vs. Effort 7 (Post) vs. Effort 4 (Pre)
Report Area

<table>
<thead>
<tr>
<th>Test Information:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre Time:</td>
<td>Date and time of Pre and Post efforts.</td>
</tr>
<tr>
<td>Post time:</td>
<td>Norm Profile used to calculate predicted values.</td>
</tr>
<tr>
<td>Norm Reference:</td>
<td>For each selected Pre and Post effort, this section provides quality indication regarding individual effort acceptability.</td>
</tr>
</tbody>
</table>

Quality Messages:

Pre: 4-Blow out longer, 2-Blow out longer, 1-Blow out longer,
Post: 7-Blow out longer, 6-Blow out longer,

Variances of best FVC and FEV1 in Pre and Post phases. ATS standards require this variance to be <150 mL. Indication of Pre and Post effort repeatability being met. If criteria is not met, the reason why is provided.

Test Results:

| Lung age:       | 63 years |
| FEV1%Pred:      | 101%     |
| FEV1%:          | 77%      |
| Improvement:    | FVC: 95%, FEV1: 97% (Post/Pre) * 100 |
| Not Significant BD Response |

Main results of the Spirometry test. See section 5 for settings that influence the amount of information shown here.

Test Interpretation: UNCONFIRMED REPORT

Pre: FVC= 2.64L, FEV1= 2.07L, FEV1% = 77.8%, FEV1/VC = 79.2%, FEV1/MaxFVC = 104%, FEV1/VC = 99%, FVC = 124%
Post: FVC= 2.5L (-6.4%), FEV1= 2.0L (-3.5%), FEV1% = 71.0% (-8.4%), FEV1/VC = 76%

Spirometry interpretation area.

Tabular presentation of a subset of measurement data.
12 Predictions

12.1 Norm Profiles

Each predictive norm supports a particular subset of parameters and covers a specific population, as detailed in the profile charts below.

<table>
<thead>
<tr>
<th>Parameters Studied</th>
<th>Norm Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>FVC</td>
<td>Olsen 1963</td>
</tr>
<tr>
<td></td>
<td>Crapo 1981</td>
</tr>
<tr>
<td></td>
<td>Dockery 1983</td>
</tr>
<tr>
<td></td>
<td>ECSCS/Quanjer 1993</td>
</tr>
<tr>
<td></td>
<td>ECSCS/Solymar 1980</td>
</tr>
<tr>
<td></td>
<td>ECSCS/Zapletal 1983</td>
</tr>
<tr>
<td></td>
<td>Falschke 2004</td>
</tr>
<tr>
<td></td>
<td>Forche II 1988**</td>
</tr>
<tr>
<td></td>
<td>GLI 2012</td>
</tr>
<tr>
<td></td>
<td>Langhammer 2011</td>
</tr>
<tr>
<td></td>
<td>Forche III 1988**</td>
</tr>
<tr>
<td></td>
<td>Hedenström 1986</td>
</tr>
</tbody>
</table>
|                   | Hedenström/Solymar 1986
|                   | Forche II 1988**|
|                   | Hibbert 1989|
|                   | Hsu 1979|

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Male</th>
<th>Female</th>
</tr>
</thead>
<tbody>
<tr>
<td>FVC</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>FEV1</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>FEV1%</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>FEV0.5</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>FEV3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>FEV3%</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>FEV6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FEV1/FEV6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PEF</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>FEF25-75</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>FEF75</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>FEF50</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>FEF25</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>FEF0.2-1.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FEV0.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SVC</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>MVV</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gender</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Male</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Female</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Pediatric</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adult</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Height (cm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Weight (kg)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Race</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Caucasian</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Black</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Hispanic</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Asian</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Native American</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

*adult population only  **Caution: Pediatric use in the US \( \geq 6\) years old
<table>
<thead>
<tr>
<th>Parameters Studied</th>
<th>Norm Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>FVC</td>
<td>X</td>
</tr>
<tr>
<td>FEV1</td>
<td>X</td>
</tr>
<tr>
<td>FEV1%</td>
<td>X</td>
</tr>
<tr>
<td>FEV0.5</td>
<td>X</td>
</tr>
<tr>
<td>FEV3</td>
<td>X</td>
</tr>
<tr>
<td>FEV6</td>
<td>X</td>
</tr>
<tr>
<td>FEV1/FEV6</td>
<td>X</td>
</tr>
<tr>
<td>PEF</td>
<td>X</td>
</tr>
<tr>
<td>PEF25-75</td>
<td>X</td>
</tr>
<tr>
<td>PEF75</td>
<td>X</td>
</tr>
<tr>
<td>PEF50</td>
<td>X</td>
</tr>
<tr>
<td>PEF25</td>
<td>X</td>
</tr>
<tr>
<td>PEF0.2-1.2</td>
<td>X</td>
</tr>
<tr>
<td>PEF0.5%</td>
<td>X</td>
</tr>
<tr>
<td>MVV</td>
<td>X</td>
</tr>
</tbody>
</table>

**Caution: Pediatric use in the US ≥ 6 years old**
## 12.2 Norm-Related Clinical Studies

Each of the following studies provides expected values for various spirometric parameters by measuring significant samples of a specific population.

<table>
<thead>
<tr>
<th>Study</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference</td>
<td>Year</td>
</tr>
<tr>
<td>-----------</td>
<td>------</td>
</tr>
</tbody>
</table>
12.3 Norm Extrapolation

Extrapolation is the practice of applying a norm’s formula to a patient whose profile doesn’t fit that norm’s profile. For example, if you were testing an 88-year-old man, and the primary (selected) norm was based on males 85 or younger, the predicted values are extrapolated values.

- When it takes place, extrapolation is indicated in the test record.
- Pediatric norms do not provide any age, weight, or height extrapolation.
- Adult norms allow extrapolation of age up, but not down.
- Adult norms allow extrapolation of height, weight, up and down.

12.4 Composite Norm Values

When the Composite norm, see tables in section 12.1, is selected, predictive parameter values are filled in from one of the alternative (composite) norm sources listed here.

<table>
<thead>
<tr>
<th>NHANESIII</th>
<th>FVC, FEV1, FEV1%, FEV6, FEV1/FEV6, FEV6/FVC, PEF, FEF25-75</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crapo 1981</td>
<td>FEV0.5, FEV3, FEV3/FVC</td>
</tr>
<tr>
<td>Morris 1971</td>
<td>FEF0.2-1.2</td>
</tr>
<tr>
<td>ECCS/Quanjer 1993</td>
<td>FEF25, FEF50, FEF75</td>
</tr>
</tbody>
</table>

Note: If an adult norm is selected but pediatric patient data is used – no prediction value will be calculated and displayed.

The following combinations of norms are supported:

<table>
<thead>
<tr>
<th>Prediction Norm</th>
<th>Age range</th>
<th>Composite norm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solymar</td>
<td>7-18</td>
<td>ECCS/Solymar</td>
</tr>
<tr>
<td>ECCS</td>
<td>19-70</td>
<td></td>
</tr>
<tr>
<td>Zapletal</td>
<td>6-18</td>
<td>ECCS/Zapletal</td>
</tr>
<tr>
<td>ECCS</td>
<td>19-70</td>
<td></td>
</tr>
<tr>
<td>Solymar</td>
<td>7-18</td>
<td>Hedenström/Solymar*</td>
</tr>
<tr>
<td>Hedenström</td>
<td>20-70</td>
<td></td>
</tr>
</tbody>
</table>

*The Composite of Hedenstrom/Solymar cannot be used for age 19

For a listing of the parameters included in each norm, see section 12.1 Norm Profiles.

12.5 Lung Age

Lung age is a calculated value based on a patient’s demographics and spirometric performance. This provides a relative indication of the health of the patient's lungs. This value is used primarily to encourage smoking cessation.

The SpiroPerfect spirometer, calculates lung age values according to the document cited in Reference 4 (Morris, 1985). For single-effort tests, lung age is based on the current effort. Otherwise, it is based on the patient’s “best” pre effort as defined in the settings.

Lung age calculations are provided only for patients 20 and older. For patients older than 84 years the lung age is extrapolated. This limitation is derived from the subject population on which Morris based his research. The lung age is one floating point number in years: the
average of the 4 formulas in the Morris article (FVC, FEV1, FEF25-75%, and FEF0.2-1.2). Specifically, lung age is calculated as follows:

**Gender Lung Age Formula**

Men  \[ \text{[5.920 (height) - 40.000 (FVC) - 169.640 + 2.870 (height) - 31.250 (FEV1) - 39.375 + 2.319 (height) - 21.277 (FEF200-1200) + 42.766 + 1.044 (height) - 22.222 (FEF25%-75%) + 55.844] / 4} \]

Women \[ \text{[4.792 (height) - 41.667 (FVC) - 118.833 + 3.560 (height) - 40.000 (FEV1) - 77.280 + 4.028 (height) - 27.778 (FEF200-1200) - 70.33 + 2.000 (height) - 33.333 (FEF25%-75%) + 18.367] / 4} \]

height in inches

### 12.6 Ethnic group correction

Studies have demonstrated that expected values for certain spirometric parameters can vary significantly from one ethnic group to another. Some norm studies include separate regression equations for different races but most others do not. In the latter case Welch Allyn CardioPerfect applies ethnic group correction to all non-Caucasian adult patients in the prediction formulas. The interpretation area will state if the norm values are extrapolated. The ATS (for blacks) or NIOSH (for Asians) recommendations will be used for extrapolation.

<table>
<thead>
<tr>
<th>Race Choices</th>
<th>FVC&amp;FEV1</th>
<th>Recommendation Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caucasian</td>
<td>No adjustment</td>
<td>-</td>
</tr>
<tr>
<td>Black</td>
<td>88%</td>
<td>ATS</td>
</tr>
<tr>
<td>Asian</td>
<td>94%</td>
<td>NIOSH</td>
</tr>
<tr>
<td>Hispanic</td>
<td>No adjustment</td>
<td>None found</td>
</tr>
<tr>
<td>Native American</td>
<td>No adjustment</td>
<td>None found</td>
</tr>
</tbody>
</table>

**Note**  
Race adjustment applies for adults only and applies to all supported parameters within the norm study.

*If a race adjustment percentage is used, the same adjustment is applied to the LLN value.*
12.7 Understanding Interpretation Results

The following diagram illustrates the process of collecting and interpreting spirometry data. For details, see the document noted in reference 8.

Figure 12.1 Data Interpretation Process

- START
- GOOD FVC
  - yes
  - no
  - REPEAT MANEUVER(S)
  - yes
  - no
- BEST OF 3?
  - yes
  - no
- RATIO ABNORMAL
  - yes
  - no
  - FVC NORMAL
- OBSTRUCTION
  - yes
  - no
- NORMAL SPIROMETRY
- RESTRICTION

- FEV1 ≥ 100% of Predicted?
  - yes
  - May be a Physiological Variant
  - no
- 70% ≤ FEV1 < 100% of Predicted?
  - yes
  - Mild Obstruction
  - no
- 60% ≤ FEV1 < 70% of Predicted?
  - yes
  - Moderate Obstruction
  - no
- 55% ≤ FEV1 < 60% of Predicted?
  - yes
  - Moderately Severe Obstruction
  - no
- 34% ≤ FEV1 < 50% of Predicted?
  - yes
  - Severe Obstruction
  - no
- FEV1 < 30% of Predicted?
  - yes
  - Very Severe Obstruction
  - no

FVC < 80% of predicted?

And low vital capacity, cannot rule out superimposed restriction.
12.8 Acceptability of an effort

(See section 12.11 references 2, 5, and 8 for details of the ATS standards.)

An individual effort is deemed acceptable by the SpiroPerfect software when:

The effort has a good start:
- extrapolated volume <5% of FVC or 150 mL, whichever is greater.

If this criterion is not met, the effort-quality message "Don't hesitate" or "Blast out faster" displays.

The effort exhibits satisfactory exhalation:
- duration ≥ 6 seconds (≥ 3 seconds for children under 10 years of age), OR
- a 1 second plateau in the volume-time curve occurs

If this criterion is not met, then the effort-quality message "Blow out longer, No plateau" displays.

(See the "Effort-Quality Message" table below for further detail.)

<table>
<thead>
<tr>
<th>Effort-Quality Message</th>
<th>Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>Don't hesitate</td>
<td>Back Extrapolated Volume (BEV) is &gt; 150 mL</td>
</tr>
<tr>
<td>Blast out faster</td>
<td>PEF time &gt; 120 ms.</td>
</tr>
<tr>
<td>Blow out longer, No plateau</td>
<td>FET &lt; 6 seconds (3 pediatrics) and no plateau</td>
</tr>
<tr>
<td>Good effort</td>
<td>FET &lt; 6 seconds (3 pediatrics) and has plateau OR</td>
</tr>
<tr>
<td></td>
<td>FET is &gt; 6 seconds (3 seconds pediatrics)</td>
</tr>
</tbody>
</table>

In addition, the clinician administering the test should assess the effort for signs of:
- cough during the initial second
- glottis closure
- early termination
- effort that is not maximal throughout
- leak
- obstructed mouthpiece

Refer to the effort acceptability poster that shipped with your product for examples of efforts that are acceptable. The poster also contains examples of inaccurate results. Delete any efforts exhibiting signs of inaccurate results. (See section 8.4 Deleting an Effort on page 46.) The poster is also accessible in the Help menu. Go to Help>Spirometry>Acceptability Poster.

12.9 Reproducibility of a test stage

Within a test stage, (i.e. either Pre or Post medication), an assessment will be made of the acceptability and reproducibility of the overall test stage. The test stage will be deemed by the software to be acceptable if:
- there are at least 3 acceptable efforts

and reproducible if:
- within the 3 acceptable efforts, the best two FVC measurements and the best two FEV1 measurements are within 150 mL
12.10 Reversibility (Bronchodilator response)

For any spirometry test that has Pre and Post efforts, significance of the BD response will be shown in the interpretation text area, stating either "Not Significant BD Response" or "Significant BD Response" as appropriate.

SpiroPerfect will deem the Bronchodilator response to be significant if either FVC or FEV1:
- Show an increase from Pre to Post of 12% or more, AND
- Have an absolute increase from Pre to Post of 200 mL or more.

12.11 Z-score

For norms that support calculation of the z-score, this value will be shown together with the % Predicted values.

12.12 References


   See in particular the calibration and reporting sections of this document.


   This document describes the methods of selecting the reference values and the algorithm for interpretative results.


   This document describes the methods of acquiring the output parameters and the required accuracy. For details on ATS/ERS acceptability criteria, see these sections:
   - “Start of Test Criteria,” page 324
   - “Manoeuvre repeatability,” page 325


13 Maintaining the Spirometer – Welch Allyn

13.1 Maintaining the Sensor

The Spirometer sensor needs little maintenance to stay in good working condition.

⚠️ WARNING ⚠️ Change the flow transducer for each patient.

⚠️ Caution ⚠️ Perform the following inspections daily:
Check that all connections are properly aligned and tight.
Visually check the pressure tubing for leaks and kinks.
Check for irreversible bending or compression of the pressure tubing between flow transducers and device.

Ensure spirometer is calibrated and that the proper lot code and calibration code is used. The lot code and calibration code can be found on the flow transducer package. For more detailed information please refer to chapter 7 the Calibration chapter of this manual.

⚠️ Caution ⚠️ Avoid placing spirometer and any of its components in direct sunlight or in a dusty environment.

To make reliable recordings, calibrate the sensor on a daily basis. Keep track of the calibrations in the calibration log.

13.2 Cleaning the Spirometer

⚠️ Caution ⚠️ You cannot clean the spirometer or any of its components.
If you choose to clean the calibrations syringe, clean the outer surface of the syringe with only the following solutions or wipes:

- Solution of dish soap and water, ½ tsp per cup of water
- Solution of bleach and water, 1 part bleach (6% sodium hypochlorite) with 9 parts water
- Isopropyl Alcohol and water, 70% by volume
- PDI Sani-Cloth Plus wipes (14.85% Isopropanol)
- Cavi-Wipes (17.2% Isopropanol)

### Warning

Satisfactory maintenance procedures must be implemented, or equipment failure and health hazards may result. Only qualified service personnel should repair the equipment. See “Limited Warranty” and “Service Policy”, page 4.

To prevent cross-contamination, do not try to clean the flow transducers and nose clips. Discard these items after a single patient use. Wear gloves when replacing flow transducers, and wash hands after touching them.

### Caution

- **Do not** clean the pressure tubing or sensor. Trapped moisture could affect accuracy.
- **Replace** the pressure tubing when it becomes dirty. Recalibrate after replacement.
- **Replace** the sensor when it becomes faulty. See section 13.4 Ordering Information for Replacement Parts on page 76.

### 13.3 Cleaning the Calibration Syringe

Clean the outer surface of the syringe with any of the following solutions or wipes:

- Solution of dish soap and water, ½ tsp per cup of water
- Solution of bleach and water, 1 part bleach (6% sodium hypochlorite) with 9 parts water
- Isopropyl Alcohol and water, 70% by volume
- PDI Sani-Cloth Plus wipes (14.85% Isopropanol)
- Cavi-Wipes (17.2% Isopropanol)

### 13.4 Discarding the Equipment

Dispose of this product and its accessories according to local regulations. Do not dispose of as unsorted municipal waste. For more specific disposal or compliance information, go to [www.welchallyn.com/weee](http://www.welchallyn.com/weee) or contact Welch Allyn Technical Support at [www.welchallyn.com/about/company/locations.htm](http://www.welchallyn.com/about/company/locations.htm).

### 13.5 Ordering Information for Replacement Parts

The following parts must be replaced as noted:

- flow transducers & nose clips – Replace for each new patient.
- pressure tubing – Replace when dirty.
- sensor – Replace when faulty.
To order parts, call the Welch Allyn Technical Support Center.

**Warning**  
Discard all spirometry components according to local regulations.

Use of components other than those recommended by Welch Allyn may compromise product performance. The Welch Allyn warranty can only be honored if you use Welch Allyn approved components and replacement parts.

**Figure 13.1 Ordering Information for Replacement Parts**

<table>
<thead>
<tr>
<th>Item</th>
<th>Part Numbers</th>
<th>Order Quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disposable Flow Transducer</td>
<td>703418</td>
<td>25 pk</td>
</tr>
<tr>
<td>(CPWS, CP200)</td>
<td>703419</td>
<td>100 pk</td>
</tr>
<tr>
<td>Package includes Lot code and Calibration code</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pressure Tubing</td>
<td>703415</td>
<td>1</td>
</tr>
<tr>
<td>(CPWS, CP200, 2m)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sensor</td>
<td>703554</td>
<td>1</td>
</tr>
<tr>
<td>Spirometer USB Kit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nose Clip</td>
<td>100680</td>
<td>1</td>
</tr>
<tr>
<td>Calibration Syringe</td>
<td>703480</td>
<td>1</td>
</tr>
<tr>
<td>3L, CPWS, CP200, SPIRO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Syringe Calibration Service</td>
<td>BASIC-LVL-CAL</td>
<td>1</td>
</tr>
<tr>
<td>BASIC-LVL2-CAL</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
# 14 Troubleshooting

<table>
<thead>
<tr>
<th>Condition</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Device (sensor) is not responding</td>
<td>Disconnect and reconnect the sensor. Check if the port settings in the settings menu correspond with the used COM-port.</td>
</tr>
<tr>
<td>Measured values are incorrect</td>
<td>Verify LOT number and perform a verification test. Check the flow transducer for potential obstruction. Do a volume calibration to check the gain-factor and to recalibrate the device if necessary. Check to ensure that the patient's lips form a tight seal around the flow transducer. Use a nose clip on the patient.</td>
</tr>
<tr>
<td>Values are too high (intermittent)</td>
<td>Retest with fingers positioned properly around the flow transducer. Do not block the end of the flow transducer with your fingers or hand. Check the flow transducer for obstruction caused by patient saliva or phlegm. Replace the flow transducer. Check to ensure that the patient's airways are not restricted by excessive bending. Correct the patient's posture.</td>
</tr>
<tr>
<td>Flow data is out of range (measured flow has exceeded the allowable limits)</td>
<td>Recalibrate with a 3-liter syringe.</td>
</tr>
<tr>
<td>The program does not predict values or the values appear incorrect</td>
<td>Check in the settings menu to see if the correct author is selected. Verify that the date of birth, gender, race and the height of the patient are correctly entered in the patient card; these are needed for the calculation of the predicted values. For some prediction norms the patient's weight is also obligatory.</td>
</tr>
<tr>
<td>Unable to calibrate</td>
<td>Verify sensor calibration information. Check the connection between flow transducer and sensor.</td>
</tr>
<tr>
<td>Condition</td>
<td>Solution</td>
</tr>
<tr>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td>Replace the flow transducer.</td>
<td></td>
</tr>
<tr>
<td>Check that the connection between the syringe and the flow transducer is tight and without leaks.</td>
<td></td>
</tr>
<tr>
<td>Use even strokes in calibration.</td>
<td></td>
</tr>
<tr>
<td>Error message: No valid stroke recorded.</td>
<td>Wait with pushing the plunger in until the blue calibration bar starts moving.</td>
</tr>
<tr>
<td></td>
<td>Pull the plunger completely out before pressing the OK button on the start calibration window.</td>
</tr>
<tr>
<td>Report does not print parameters or graphs</td>
<td>Check print and parameters settings.</td>
</tr>
<tr>
<td>Indistinguishable Pre and Post curves on printed reports</td>
<td>A color printer and a color printout are recommended for printing Spirometry reports. Printing these reports with a monochrome printer or in black and white can lead to confusion as it is not easy to identify which curve is a Pre and which is a Post effort.</td>
</tr>
<tr>
<td>Patient test values differ from values expected by physician</td>
<td>Verify sensor calibration information.</td>
</tr>
<tr>
<td></td>
<td>Verify the barometric pressure.</td>
</tr>
<tr>
<td></td>
<td>Recalibrate.</td>
</tr>
<tr>
<td></td>
<td>Replace transducer.</td>
</tr>
<tr>
<td></td>
<td>Verify the patient data. The norm selection is dependent upon accurate input of patient data in the SpiroPerfect database.</td>
</tr>
<tr>
<td></td>
<td>Eliminate any leaks in the pressure tubing.</td>
</tr>
<tr>
<td></td>
<td>Replace the sensor if damaged.</td>
</tr>
<tr>
<td></td>
<td>Make sure the patient remains still during recording.</td>
</tr>
<tr>
<td>The flow sensor has been dropped</td>
<td>Recalibrate.</td>
</tr>
<tr>
<td>Loss of network connection during spirometry test</td>
<td></td>
</tr>
</tbody>
</table>
### 15 Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SpiroPerfect</td>
<td>Computer based full diagnostic spirometer</td>
</tr>
<tr>
<td>Tests</td>
<td>FVC, SVC, MVV, Pre-Post BD</td>
</tr>
<tr>
<td>Sensor Type</td>
<td>Pneumotach</td>
</tr>
<tr>
<td>Power Equipment</td>
<td>None, obtained from USB port</td>
</tr>
<tr>
<td>Accuracy</td>
<td>Meets or exceeds ATS/ERS 2005 standard</td>
</tr>
<tr>
<td>Reproducibility</td>
<td>Meets or exceeds ATS/ERS 2005 standard</td>
</tr>
<tr>
<td>Volume Range</td>
<td>0-14 L</td>
</tr>
<tr>
<td>Flow Range</td>
<td>+/- 14 L/sec</td>
</tr>
<tr>
<td>Predictive Norms</td>
<td>For Predictive Norms included, see 12.2</td>
</tr>
<tr>
<td></td>
<td>Additional predictive norms can be added upon customer request</td>
</tr>
<tr>
<td>Interpretation</td>
<td>1991 ATS Interpretation Standards.</td>
</tr>
<tr>
<td></td>
<td>Automatic interpretation can be disabled.</td>
</tr>
<tr>
<td></td>
<td>Manual Interpretation available.</td>
</tr>
<tr>
<td></td>
<td>Lung Age calculation</td>
</tr>
<tr>
<td>Reports</td>
<td>FVC - Volume / Time</td>
</tr>
<tr>
<td></td>
<td>FVC - Flow / Volume</td>
</tr>
<tr>
<td></td>
<td>FVC - Both – Volume / Time and Flow / Volume</td>
</tr>
<tr>
<td></td>
<td>SVC – Volume / Time</td>
</tr>
<tr>
<td>Incentive graphic</td>
<td>Fireman</td>
</tr>
<tr>
<td>Parameters</td>
<td>FVC, FIV, FIV1, FIV1%, FEV0.5, FEV1, FEV2, FEV3, FEV5, FEV6, FEV0.5,</td>
</tr>
<tr>
<td></td>
<td>FEV0.5%, FEV1%, FEV1/FVC, FEV2%, FEV3%, FEV5%, FEV6%, PEF, FEF25,</td>
</tr>
<tr>
<td></td>
<td>FEF50, FEF75, FEF0.2-1.2, FEF25-75, FEF75-85, PIF, FIF50, FEF50/FIF50,</td>
</tr>
<tr>
<td></td>
<td>FEV1/FEV6, FET, MEF25, MEF50, MEF75</td>
</tr>
<tr>
<td></td>
<td>SVC, ERV, IRV, VT, IC, BF, MV, Tin, Tex, Tin/Tex MVV, MV, VT, BF, DFRC</td>
</tr>
<tr>
<td>Quality Checks</td>
<td>ATS Acceptability and ATS Reproducibility checks</td>
</tr>
<tr>
<td></td>
<td>Audio and visual incentive for assistance in coaching patients</td>
</tr>
<tr>
<td>Connectivity</td>
<td>Compatible with CardioPerfect Workstation</td>
</tr>
<tr>
<td></td>
<td>Export compatible with most electronic medical records programs</td>
</tr>
<tr>
<td></td>
<td>Available in multi user network</td>
</tr>
<tr>
<td></td>
<td>Telemedicine option for e-mail transfer</td>
</tr>
<tr>
<td>Storage and</td>
<td>• Temperatures between –20 °C (-4 °F) and 50 °C (122 °F).</td>
</tr>
<tr>
<td>Environment</td>
<td>• Relative humidity between 15 and 95% (non-condensing).</td>
</tr>
<tr>
<td></td>
<td>• Atmospheric Pressure of 500 hPa (mbar) to 1,060 hPa (mbar).</td>
</tr>
</tbody>
</table>
## Specification

<table>
<thead>
<tr>
<th>Specification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation Environment</td>
<td>• Temperatures between 10 °C (50 °F) and 40 °C (104 °F),</td>
</tr>
<tr>
<td></td>
<td>• Relative humidity between 15% and 90% (non-condensing),</td>
</tr>
<tr>
<td></td>
<td>• Atmospheric Pressure of 700 hPa (mbar) to 1,060 hPa (mbar),</td>
</tr>
<tr>
<td></td>
<td>• Warm up period of 5 minutes.</td>
</tr>
<tr>
<td>Mode of Operation</td>
<td>Continuous</td>
</tr>
</tbody>
</table>
16 Statutory and Regulatory Requirements

MDD - Medical Device Directive (MDD) 93/42/EEC
IEC/EN 60601-1, Medical Electrical Equipment, General Requirements for safety, Safety
requirements for medical electrical systems.
IEC/EN 60601-1 Medical Electrical Equipment – General Requirements for Safety
IEC 60601-1-2 Medical Electrical Equipment - Safety Requirements - EMC
IEC/EN 60601-1-4 Collateral Standard for Programmable Medical Systems
CAN/CSA C22.2 No. 601.1-M90/UL 60601-1, Medical Electrical Equipment – General
Requirements for Safety

<table>
<thead>
<tr>
<th>EC REP</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

Regulatory Affairs Representative
Welch Allyn, Limited
Navan Business Park
Dublin Road
Navan, County Meath,
Republic of Ireland

Welch Allyn
4341 State Street Road
Skaneateles Falls, NY 13153 USA
Tel: 800 535-6663 (North America Only) or 315 685-4560
Fax: 315 685-3361
www.welchallyn.com
## 17 Guidance and Manufacturer’s Declarations

### Caution

The Welch Allyn SpiroPerfect spirometer needs special precautions regarding EMC and needs to be installed and put into service according to the following EMC information provided. Portable and mobile RF communications equipment can affect the Welch Allyn SpiroPerfect spirometer.

### Electromagnetic Emissions

The Welch Allyn SpiroPerfect is intended for use in the electromagnetic environment specified below. The customer or the user of the Spirometer should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Emissions test</th>
<th>Compliance</th>
<th>Electromagnetic environment – guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF emissions</td>
<td>Group 1</td>
<td>The Welch Allyn SpiroPerfect uses RF energy only for its internal function. Therefore, its RF emissions are very low and are not likely to cause any interference in nearby electronic equipment.</td>
</tr>
<tr>
<td>CISPR 11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RF emissions</td>
<td>Class A</td>
<td>The Welch Allyn SpiroPerfect is suitable for use in all establishments other than domestic, and may be used in domestic establishments and those directly connected to the public low-voltage power supply network that supplies buildings used for domestic purposes, provided the following warning is heeded: <strong>Warning</strong>: This equipment/system is intended for use by healthcare professionals only. This equipment/system may cause radio interference or may disrupt the operation of nearby equipment. It may be necessary to take mitigation measures, such as re-orienting or relocating the Welch Allyn SpiroPerfect or shielding the location.</td>
</tr>
<tr>
<td>CISPR 11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Harmonic emissions</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>IEC 61000-3-2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voltage fluctuations/</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>flicker emissions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IEC 61000-3-3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Electromagnetic Immunity

The Welch Allyn SpiroPerfect is intended for use in the electromagnetic environment specified below. The customer or the user of the Spirometer should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment — guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrostatic discharge (ESD) IEC 61000-4-2</td>
<td>±6 kV contact</td>
<td>±6 kV contact</td>
<td>Floors should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the relative humidity should be at least 30%.</td>
</tr>
<tr>
<td></td>
<td>±8 kV air</td>
<td>±8 kV air</td>
<td></td>
</tr>
<tr>
<td>Electrical fast transient/burst IEC 61000-4-4</td>
<td>±2 kV for power supply lines</td>
<td>Not Applicable</td>
<td>Mains power quality should be that of a typical commercial or hospital environment.</td>
</tr>
<tr>
<td></td>
<td>±1 kV for input/output lines</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Surge IEC 61000-4-5</td>
<td>±1 kV differential mode</td>
<td>Not Applicable</td>
<td>Mains power quality should be that of a typical commercial or hospital environment.</td>
</tr>
<tr>
<td></td>
<td>±2 kV common mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voltage dips, short interruptions and voltage variations on power supply input lines IEC 61000-4-11</td>
<td>&lt;5 % ( \frac{U}{T} ) (( &gt;95 % ) dip in ( \frac{U}{T} )) for 0,5 cycle</td>
<td>Not Applicable</td>
<td>Mains power quality should be that of a typical commercial or hospital environment. If the user of the Welch Allyn SpiroPerfect requires continued operation during power mains interruptions, it is recommended that the Welch Allyn SpiroPerfect be powered from an uninterruptible power supply or a battery.</td>
</tr>
<tr>
<td></td>
<td>40 % ( \frac{U}{T} ) (60 % dip in ( \frac{U}{T} )) for 5 cycles</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>70 % ( \frac{U}{T} ) (30 % dip in ( \frac{U}{T} )) for 25 cycles</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;5 % ( \frac{U}{T} ) (( &gt;95 % ) dip in ( \frac{U}{T} )) for 5 sec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power frequency (50/60 Hz) magnetic field IEC 61000-4-8</td>
<td>3 A/m</td>
<td>3 A/m</td>
<td>Power frequency magnetic fields should be at levels characteristic of a typical location in a typical commercial or hospital environment.</td>
</tr>
</tbody>
</table>

NOTE \( \frac{U}{T} \) is the AC mains voltage prior to application of the test level.
## Electromagnetic Immunity

The Welch Allyn SpiroPerfect is intended for use in the electromagnetic environment specified below. The customer or the user of the Welch Allyn SpiroPerfect should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment – guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conducted RF</td>
<td>3 Vrms, 150 kHz to 80 MHz</td>
<td>3 Vrms</td>
<td>Portable and mobile RF communications equipment should be used no closer to any part of the Welch Allyn SpiroPerfect, including cables, than the recommended separation distance calculated from the equation applicable to the frequency of the transmitter.</td>
</tr>
<tr>
<td>Radiated RF</td>
<td>3 V/m, 80 MHz to 2,5 GHz</td>
<td>3 V/m</td>
<td>Recommended separation distance</td>
</tr>
</tbody>
</table>

\[ d = 1.2 \cdot \sqrt{P} \quad \text{80 to 800 MHz} \]

\[ d = 2.3 \cdot \sqrt{P} \quad \text{800 MHz to 2,5 GHz} \]

where \( P \) is the maximum output power rating of the transmitter in watts (W) and \( d \) is the recommended separation distance in meters (m).

Field strengths from fixed RF transmitters, as determined by an electromagnetic site survey, should be less than the compliance level in each frequency range. Interference may occur in the vicinity of equipment marked with the following symbol:

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies.

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.

- Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the Welch Allyn SpiroPerfect is used exceeds the applicable RF compliance level above, the Welch Allyn SpiroPerfect should be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as reorienting or relocating the Welch Allyn SpiroPerfect.

- Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
Recommended separation distances between portable and mobile RF communications equipment and the Welch Allyn SpiroPerfect

The Welch Allyn SpiroPerfect is intended for use in an electromagnetic environment in which radiated RF disturbances are controlled. The customer or the user of the Welch Allyn SpiroPerfect can help prevent electromagnetic interference by maintaining a minimum distance between portable and mobile RF communications equipment (transmitters) and the Welch Allyn SpiroPerfect as recommended below, according to the maximum output power of the communications equipment.

<table>
<thead>
<tr>
<th>Rated maximum output power of transmitter W</th>
<th>Separation distance according to frequency of transmitter m</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>150 KHz to 80 MHz</td>
</tr>
<tr>
<td></td>
<td>$d = 1.2 \cdot \sqrt{P}$</td>
</tr>
<tr>
<td>0.01</td>
<td>0.12</td>
</tr>
<tr>
<td>0.1</td>
<td>0.37</td>
</tr>
<tr>
<td>1</td>
<td>1.2</td>
</tr>
<tr>
<td>10</td>
<td>3.7</td>
</tr>
<tr>
<td>100</td>
<td>12</td>
</tr>
</tbody>
</table>

For transmitters rated at a maximum output power not listed above, the recommended separation distance $d$ in meters (m) can be estimated using the equation applicable to the frequency of the transmitter, where $P$ is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.

NOTE 1 At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.
18 Function keys

The Welch Allyn CardioPerfect module is, just like all Windows applications, designed for working with the mouse. However, there might be situations in which working with the keyboard can be quicker. Therefore a number of functions within the Welch Allyn CardioPerfect module can also be selected directly using the keyboard. Here is a list of all available keyboard shortcuts in this module, for a more general function key description please refer to the Workstation manual:

**Spirometry functions**

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>(SHIFT)+(CTRL)+(S)</td>
<td>Starts a new spirometry recording.</td>
</tr>
<tr>
<td>F6</td>
<td>Reanalyze</td>
</tr>
<tr>
<td>F7</td>
<td>Comparison</td>
</tr>
<tr>
<td>F9</td>
<td>Opens the Ambient settings dialog</td>
</tr>
<tr>
<td>F10</td>
<td>Starts the Calibration process</td>
</tr>
<tr>
<td>(CTRL)+(L)</td>
<td>Opens the Calibration log</td>
</tr>
<tr>
<td>(CTRL)+(E)</td>
<td>Add new effort</td>
</tr>
<tr>
<td>(CTRL)+(I)</td>
<td>Opens the Interpretation window</td>
</tr>
<tr>
<td>(CTRL)+(H)</td>
<td>Opens the Interpretation History</td>
</tr>
<tr>
<td>(CTRL)+(D)</td>
<td>Delete current effort</td>
</tr>
<tr>
<td>(CTRL)+(T)</td>
<td>Edit comment</td>
</tr>
</tbody>
</table>

**Recording new test**

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F2</td>
<td>Start/stop test</td>
</tr>
<tr>
<td>(Esc)</td>
<td>Exit the recording, cannot exit when recording is active.</td>
</tr>
<tr>
<td>(ALT)+F4</td>
<td>Close recording/test</td>
</tr>
</tbody>
</table>
19 Glossary

**adult.** Generally, 18 or older. Age limits vary with each norm.

**ASS.** American Security Society.

**ATS.** American Thoracic Society. An organization that provides standards for spirometry common practice and equipment.

**ATS acceptability criteria.** Applicable to FVC testing only. (1) Criteria ensuring that an individual effort started and ended satisfactorily (no leaks or coughs). (2) Criteria ensuring that the patient has made at least two efforts of the same kind (two FVC-pre or two FVC-post), and that these efforts are reproducible. For details, see document noted in reference 5.

**ATS interpretive results.** The software calculates interpretive results as described in the document noted in reference 2.

**baseline.** See pre-test.

**best effort.** A measurement calculated from a set of efforts. The formula for calculating best effort is user-selectable: (1) the single best effort or (2) a composite of best parameter values.

**BF.** Breathing frequency. See also MV and tidal breathing.

**bronchospasm evaluation.** See post-test.

**BTPS.** Body conditions, normal body temperature (37° C), ambient pressure, saturated with water vapor. The BTPS correction factor converts ambient conditions—temperature, humidity, and pressure—to BTPS.

**CardioPerfect workstation.** A PC using Welch Allyn CardioPerfect software. Stores ECG and spirometry test data. Can communicate with other electronic patient-information systems, such as billing and medical records.

**composite norm value.** A value that is filled in from another norm—a "composite norm source"—when the primary (selected) norm does not support a given parameter. Applicable only when "composite norm values" is enabled.

**COPD.** Chronic obstructive pulmonary disease. Characterized by airflow obstruction that is primarily caused by smoking. Examples include emphysema, chronic bronchitis, and asthmatic bronchitis.

**curve.** A graphical display of spirometry data. During SVC testing, only one curve type is available: volume/time. During FVC testing, three curve types are available: volume/time, flow/volume, and flow/time.

**effort.** A single spirometry maneuver, for example, one blow. A test typically comprises multiple efforts. See also best effort and test.

**ERS.** European Respiratory Society.

**ERV.** Expiratory reserve volume (in liters). The maximum volume that can be expired from the level of the functional residual capacity (FRC). See also tidal breathing.

**extrapolation.** The practice of applying a norm’s formula to a patient who doesn’t fit that norm’s demographics. For example, if you were testing an 88-year-old man, and the primary
(selected) norm were based on males 85 or younger, the predicted values would be extrapolated values.

**FEF50/FIF50.** The ratio of these two parameters. See FEF50 and FIF50.

**FEF25.** Forced expiratory flow (in L/s) at 25% of FVC.

**FEF50.** Forced expiratory flow (in L/s) at 50% of FVC.

**FEF75.** Forced expiratory flow (in L/s) at 75% of FVC.

**FEF85.** Forced expiratory flow (in L/s) at 85% of FVC.

**FEF0.2-1.2.** Forced expiratory flow average (in L/s) between 0.2 and 1.2 liters of FVC.

**FEF25-75.** Forced expiratory flow average (in L/s) during the middle half of FVC.

**FEF75-85 (“late” FEF).** Forced expiratory flow average (in L/s) between 75% and 85% of FVC.

**FET.** Forced expiratory time (in seconds). The elapsed time from the beginning of expiration until a specified percentage of FVC.

**FEV0.5.** Forced expiratory volume (in liters) at 0.5 seconds.

**FEV1.** Forced expiratory volume (in liters) at 1 second. An important parameter because it reflects the severity of COPD.

**FEV1/FEV6.** The ratio of these two parameters. See FEV1 and FEV6.

**FEV1/FVC.** See FEV1%.

**FEV2.** Forced expiratory volume (in liters) at 2 seconds.

**FEV3.** Forced expiratory volume (in liters) at 3 seconds.

**FEV5.** Forced expiratory volume (in liters) at 5 seconds.

**FEV6.** Forced expiratory volume (in liters) at 6 seconds.

**FEV0.5%.** FEV0.5 as % of FVC.

**FEV1%.** FEV1 as % of FVC. Same as FEV1/FVC. A parameter for a single FVC effort.

**FEV1% formula.** A user-selectable formula that determines the calculation method for a test’s (not an effort’s) overall FEV1% value, which affects the automatic interpretation.

**FEV2%.** FEV2 as % of FVC.

**FEV3%.** FEV3 as % of FVC.

**FEV5%.** FEV5 as % of FVC.

**FEV6%.** FEV6 as % of FVC.

**FEVt.** Timed forced expiratory volume (in liters). Volume of air exhaled in the specified time during an FVC effort.
FIF50. Forced inspiratory flow (in L/s) at 50% of FIVC.

FIV1. Forced inspiratory volume (in liters) at one second.

FIV1%. FIV1 as % of FIVC.

FIVC. Forced inspiratory vital capacity (in liters). The maximum volume of air that can be inspired during forced inspiration starting from full expiration.

FIVt. Timed forced inspiratory volume (in liters). Volume of air inhaled in the specified time (t).

flow. The speed at which air is inhaled or exhaled (in L/s).

flow = f(v). See flow/volume.

flow/volume. Same as flow over volume or flow = f(V). A type of data curve available during FVC testing. The y axis represents flow (L/s); the x axis represents volume (liters).

flow loop. A flow/volume curve that includes inspiratory data (negative values on the y axis).

FRC. Functional residual capacity (in liters). Volume of air remaining in the lungs and airway at the average end-expiratory level.

FVC. Forced vital capacity. (1) A type of test in which patients inhale fully and exhale forcefully for as long as they can. The goal: to measure the volume and flow of air. May or may not include forced inhaling. When forced inhaling is included, it may be done either before or after exhaling. See flow loop. (2) An important parameter (in liters): the maximum volume of air that can be delivered during forced expiration starting from full inspiration.

IC. Inspiratory capacity (in liters). The maximum volume of air that can be inhaled after a normal—unforced—exhalation. See also tidal breathing.

incentive screen. An animated screen that gives patients—usually children—a goal to achieve while exhaling. This screen is listed as a type of “curve” (data display) available during FVC testing.

IRV. Inspiratory reserve volume (in liters). The maximum volume that can be inspired from the average end-inspiratory level. See also tidal breathing.

LLN. Lower limit of normal. The lowest expected value for a spirometric parameter. The method of determining this value varies from norm to norm. LLN is displayed together with the predicted value.

lung age. A calculated value based on a patient’s demographics and spirometric performance that gives a relative indication of the health of the subject’s lungs. This value is used primarily to encourage smoking cessation. Lung age is not available for patients younger than 20 years.

maneuver. See effort.

MV. Minute volume (in liters). The volume of air expired per minute measured over at least one minute. MV = BF • VT. See also tidal breathing.

norm. A research-based spirometry data set with a specific profile for race, gender, age, and height. The software compares each patient’s results with data in the primary (selected) norm, reporting the results as percentages of the predicted (normal) values.

normal. Consistent with norm data.
parameter. A commonly defined attribute of a spirometric waveform (FVC, FEV1, and so on).

pediatric. Generally, under 18 years old. Age limits vary with each norm. Also young children's lung sizes vary greatly. Norm values and interpretive results are not available for patients under 3 years of age. Pediatric use in the US for ages 6 and above.

PEF. Peak expiratory flow (in L/s). The largest expiratory flow achieved with a forced effort.

PIF. Peak inspiratory flow (in L/s). The largest inspiratory flow achieved with a forced effort.

post-test. A test that provides data to compare with pre-test data. Sometimes called post-Rx or post-BD (bronchodilator). A post-test must follow a pre-test within 24 hours. See also reversibility.

predictive curve. A curve that follows a set of predictive points.

predictive points. Key values from the selected norm and from composite norms (if enabled). Applicable for FVC tests only. For flow/volume curves, predictive values are PEF, FEF25, FEF50, FEF75, and FVC (all are represented as points). For volume/time curves, predictive values are FEV1 (represented as point) and FVC (represented as horizontal line). If predictive points are enabled, all available values appear on the screen and the printout.

pre-test. A test that provides a baseline for comparison with a post-test taken by the same patient. Sometimes called pre-Rx or pre-BD (bronchodilator). Pre-tests and post-tests are commonly used to evaluate the effectiveness of medication. See also reversibility.

reversibility. The percentage difference between pre-test and post-test data. This measurement indicates the effect of medication on lung function. Reversibility applies to each parameter separately. The reversibility formula, which determines the way in which reversibility is calculated, is user-selectable.

SVC. Slow (relaxed) vital capacity. (1) A type of test in which patients breathe normally several times, then inhale maximally and exhale maximally, or vice versa. (2) An important parameter (in liters): the maximum volume of air exhaled from the point of maximum inhalation, or maximum volume of air inhaled from a point of maximum exhalation.

test. A set of efforts—at least 1 and no more than 12—in various possible combinations of FVC efforts, SVC efforts, or both. Tests may include pre- and post-efforts (FVC or SVC to measure the effectiveness of medication.

Tex. Tidal breathing expiration time (in seconds). See also tidal breathing.

tidal breathing. Spontaneous or normal breathing. See also Tin and Tex.

tidal volume. See VT.

Tin. Tidal breathing inspiration time (in seconds). See also tidal breathing.

Tin/Tex. The ratio of these two parameters. See also Tin and Tex.

TV. See VT.

variance. The difference between the best and second best effort's parameter for FEV1 and FVC. Pretest and post-test variance are reported separately. See also best effort.

VC. Vital capacity. See also FVC and SVC.
volume = f(t). See volume/time.

volume/time. Same as volume over time or volume = f(t). A type of data curve available during both FVC and SVC testing. The y axis represents liters; the x axis represents seconds.

VT. Tidal volume (in liters). Also called TV, although VT is the preferred abbreviation. The volume of air that enters the lungs during inspiration and leaves the lungs during expiration in a normal breathing cycle. See also MV and tidal breathing.

workstation. See CardioPerfect workstation.

z. A dimensionless value that indicates how many standard deviations a measurement is away from the predicted value. For example, z = -1 means that the measured parameter value is one standard deviation below the predicted value. The z-score will be shown together with the % predicted values for the norms that support z-score calculation.
CardioPerfect Workstation
SpiroPerfect Module – User Manual

Index
add test information.......................... 49
ambient Settings................................. 31
ATS acceptability criteria...................... 24
best composite .................................. 23
best effort ......................................... 23
manual selection ................................ 24
calibration of flow sensor ....................... 33
comment editor .................................. 30
add or change comments ...................... 47
compare............................................ 48, 49, 51, 58
 composite norm values ......................... 70
delete effort ...................................... 46
flow transducer
  disposable...................................... 13, 77
incentive screen ................................ 44
interpretation ................................... 59
area .................................................. 20, 52, 56

automatic ........................................... 22, 59, 60
confirm ............................................ 59
history ............................................. 60, 72
Interpretation
  editor ............................................ 59
  history .......................................... 60
  lung age ........................................ 70
patient procedures
  FVC effort ....................................... 46
  FVC loop ........................................ 46
  MVV effort ..................................... 46
  SVC effort ....................................... 46
  SVC ............................................... 27, 50, 54
patient procedures ...................... 46
symbols .......................................... 9
troubleshooting ................................ 78
warranty ......................................... 2, 3